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 WARNING

Only qualified persons knowledgeable in the installation, operation, and maintenance 
of overhead and underground electric distribution equipment, along with all associated 
hazards, may install, operate, and maintain the equipment covered by this publication . 
A qualified person is someone trained and competent in:

 ● The skills and techniques necessary to distinguish exposed live parts from nonlive 
parts of electrical equipment

 ● The skills and techniques necessary to determine the proper approach distances 
corresponding to the voltages to which the qualified person will be exposed

 ● The proper use of special precautionary techniques, personal protective equipment, 
insulated and shielding materials, and insulated tools for working on or near 
exposed energized parts of electrical equipment

These instructions are intended only for such qualified persons . They are not intended 
to be a substitute for adequate training and experience in safety procedures for this 
type of equipment .

NOTICE

Thoroughly and carefully read this instruction sheet and all materials included in 
the product’s instruction handbook before installing or operating an IntelliTeam SG 
Automatic Restoration System . Become familiar with the Safety Information on page 5 . 
The latest version of this publication is available online in PDF format at sandc .com/
en/contact-us/product-literature/ .

This instruction sheet is a permanent part of the IntelliTeam SG Automatic Restoration Sys-
tem. Designate a location where users can easily retrieve and refer to this publication.

Qualified Persons

Read this 
Instruction Sheet

Retain this 
Instruction Sheet

S&C Instruction Sheet 1044-570  3
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Warranty The warranty and/or obligations described in S&C’s Price Sheet 150, “Standard Conditions 
of Sale–Immediate Purchasers in the United States,” (or Price Sheet 153, “Standard 
Conditions of Sale–Immediate Purchasers Outside the United States”), plus any special 
warranty provisions, as set forth in the applicable product-line specification bulletin, 
are exclusive. The remedies provided in the former for breach of these warranties shall 
constitute the immediate purchaser’s or end user’s exclusive remedy and a fulfillment of 
the seller’s entire liability. In no event shall the seller’s liability to the immediate purchaser 
or end user exceed the price of the specific product that gives rise to the immediate pur-
chaser’s or end user’s claim. All other warranties, whether express or implied or arising 
by operation of law, course of dealing, usage of trade or otherwise, are excluded. The 
only warranties are those stated in Price Sheet 150 (or Price Sheet 153), and THERE 
ARE NO EXPRESS OR IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS 
FOR A PARTICULAR PURPOSE. ANY EXPRESS WARRANTY OR OTHER OBLIGATION 
PROVIDED IN PRICE SHEET 150 (OR PRICE SHEET 153) IS GRANTED ONLY TO THE 
IMMEDIATE PURCHASER AND END USER, AS DEFINED THEREIN. OTHER THAN AN 
END USER, NO REMOTE PURCHASER MAY RELY ON ANY AFFIRMATION OF FACT OR 
PROMISE THAT RELATES TO THE GOODS DESCRIBED HEREIN, ANY DESCRIPTION 
THAT RELATES TO THE GOODS, OR ANY REMEDIAL PROMISE INCLUDED IN PRICE 
SHEET 150 (OR PRICE SHEET 153).

End User License 
Agreement

The end user is granted a nontransferable, non-sublicensable, nonexclusive license to use 
the IntelliTeam Designer software, IntelliLink Setup Software, IntelliTeam SG Automatic 
Restoration software, and/or other software furnished with the IntelliTeam SG Automatic 
Restoration System only upon acceptance of all the terms and conditions of the seller’s 
end-user license agreement set forth in Price Sheet 155.

4  S&C Instruction Sheet 1044-570

Introduction



Several types of safety-alert messages may appear throughout this instruction sheet. Become 
familiar with these types of messages and the importance of these various signal words:

 DANGER

“DANGER” identifies the most serious and immediate hazards that will likely result in 
serious personal injury or death if instructions, including recommended precautions, 
are not followed .

 WARNING

“WARNING” identifies hazards or unsafe practices that can result in serious personal 
injury or death if instructions, including recommended precautions, are not followed .

 CAUTION

“CAUTION” identifies hazards or unsafe practices that can result in minor personal 
injury if instructions, including recommended precautions, are not followed .

NOTICE

“NOTICE” identifies important procedures or requirements that can result in product or 
property damage if instructions are not followed .

If any portion of this instruction sheet is unclear and assistance is needed, contact the near-
est S&C Sales Office or S&C Authorized Distributor. Their telephone numbers are listed 
on S&C’s website sandc.com, or call the S&C Global Support and Monitoring Center at 
1-888-762-1100.

NOTICE

Read this instruction sheet thoroughly and carefully before 
using the IntelliTeam Designer software .

If additional copies of this instruction sheet are required, contact the nearest S&C Sales 
Office, S&C Authorized Distributor, S&C Headquarters, or S&C Electric Canada Ltd.

It is important that any missing, damaged, or faded labels on the equipment be replaced 
immediately. Replacement labels are available by contacting the nearest S&C Sales Office, 
S&C Authorized Distributor, S&C Headquarters, or S&C Electric Canada Ltd.

Understanding 
Safety-Alert 
Messages

Following Safety 
Instructions

Replacement 
Instructions 
and Labels

S&C Instruction Sheet 1044-570  5
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S&C’s IntelliTeam Designer software has an easy, intuitive user interface for configuring 
the IntelliTeam Automatic Restoration System. The drawing environment uses a familiar 
set of drawing tools for developing the circuit that are similar to other dialog boxes-based  
drawing programs. 

Simply draw the distribution system, configure attributes such as load constraints 
and RTU addresses, and use the Validate tool to complete the configuration process. 
When the circuit has been validated, use IntelliTeam Designer to push the configuration 
settings to the devices in the field.

Overview

Table 1 shows the S&C IntelliTeam Designer software revision required for use with 
various S&C device software revisions.

Table 1 . Software Compatibility Matrix—IntelliTeam Designer

IT Designer 
Release Date

IT Designer 
Revision

IntelliRupter 
R2 Control 

Installer

IntelliRupter 
R3 Control 

Installer

IntelliNode 
Installer

68xx Series 
Installer

11/23/2010 1 .0 .0 .5● 2 .3 .3 N/A 1 .6 .8 N/A

8/1/2011 2 .1 .x .x■ 3 .2 .9 N/A 1 .7 .6 3 .2 .x

3/1/2012
3 .0 .x .x or 
3 .1 .x .x■

3 .3 .x N/A 3 .3 .x 3 .3 .x

3/8/2012
3 .0 .x .x or 
3 .1 .x .x■

3 .4 .x .x N/A 3 .4 .x .x 3 .4 .x .x

3/11/2013 4 .0 .x .x■ 3 .5 .x .x N/A 3 .5 .x .x 3 .5x .x

11/11/2013 5 .0 .x .x■ 3 .6 .x .x N/A 3 .6 .x .x 3 .6 .x .x

4/2/2015 6 .0 .42 .0■ 6 .1 .x .x N/A 6 .1 .x .x 6 .1 .x .x

7/8/2016 6 .0 .43 .17■
6 .1 .x .x or 
6 .3 .x .x N/A 6 .1 .x .x or 

6 .3 .x .x
6 .1 .x .x or  
6 .3 .x .x

7/31/2017 7 .1 .x .x■
6 .1 .x .x or
6 .3 .x .x or 

7 .1 .x .x
N/A

6 .1 .x .x or
6 .3 .x .x or 

7 .1 .x .x

6 .1 .x .x or
6 .3 .x .x or  

7 .1 .x .x

9/21/2020 7 .3 .x .107▲

6 .1 .x .x or
6 .3 .x .x or
7 .1 .x .x or
7 .3 .x .x
7 .4 .x .x

7 .3 .x .x

6 .1 .x .x or
6 .3 .x .x or
7 .1 .x .x or
7 .3 .x .x

6 .1 .x .x or
6 .3 .x .x or
7 .1 .x .x or 
7 .3 .x .x

8/31/2021 7 .5 .x .x▲

6 .1 .x .x or
6 .3 .x .x or
7 .1 .x .x or
7 .3 .x .x
7 .4 .x .x
7 .5 .x .x

7 .3 .x .x
7 .5 .x .x

6 .1 .x .x or
6 .3 .x .x or
7 .1 .x .x or
7 .3 .x .x
7 .5 .x .x

6 .1 .x .x or
6 .3 .x .x or
7 .1 .x .x or 
7 .3 .x .x
7 .5 .x .x

Software Compatibility

TABLE CONTINUED ▶
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● IntelliTeam Designer software is included in the product installer and is activated with a license key .

■ IntelliTeam Designer version 2 .1 .x .x and later installers are available for download at the S&C Automation 
Customer Support Portal in the IntelliTeam SG system workspace . They require installation of a customer 
activation file, which must contain the registered MAC address of the computer using the IntelliTeam Designer 
program . To use IntelliTeam Designer version 3 .1 .x .x or later, all field device revisions must be the latest 
revision .

▲ IntelliTeam Designer version 7 .3 .x .x or later only requires the registration of a single MAC address to use 
the application .

IT Designer 
Release Date

IT Designer 
Revision

IntelliRupter 
R2 Control 

Installer

IntelliRupter 
R3 Control 

Installer

IntelliNode 
Installer

68xx Series 
Installer

2/xx/2024 7 .6 .x .x▲

6 .1 .x .x or
6 .3 .x .x or
7 .1 .x .x or
7 .3 .x .x
7 .4 .x .x
7 .5 .x .x
7 .6 .x .x

7 .3 .x .x
7 .5 .x .x
7 .6 .x .x

6 .1 .x .x or
6 .3 .x .x or
7 .1 .x .x or
7 .3 .x .x
7 .5 .x .x
7 .6 .x .x

6 .1 .x .x or
6 .3 .x .x or
7 .1 .x .x or 
7 .3 .x .x
7 .5 .x .x
7 .6 .x .x

Table 1 . Software Compatibility Matrix—IntelliTeam Designer—Continued
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NOTICE
A remote or local firmware upgrade puts a control into the Prohibit Restoration state .  
When upgrading controls in an IntelliTeam SG system, use the following procedure:

STEP  1 .  Upgrade the control software . This can be done with IntelliLink® Setup 
Software .

STEP  2 .  After the upgrade, verify that all settings were preserved .

STEP  3 .  Use the IntelliTeam Designer version compatible with the control software 
version to repush IntelliTeam SG system configuration to all FeederNets 
that have updated devices .

STEP  4 .  If a device is an open point, push the configuration to both FeederNets for 
that device .

STEP  5 .  Verify the team configurations .

STEP  6 .  For IntelliNode™ Interface Modules only, set the External Device Data 
Updated setpoint to the Running mode .

STEP  7 .  Enable the Automatic Restoration mode on all upgraded controls .

To install IntelliTeam Designer software on the computer, these are needed:

• A portable personal computer with Microsoft® Windows® 10, an Intel® Core™ i7  
processor with 8 GB of RAM (recommended), or a dual-core processor with 4 GB of RAM  
(minimum), an onboard Ethernet card, an onboard wireless card (including USB), an 
Internet browser, and access to sandc.com

• Administrative privileges

Computer 
and Software 
Requirements

The IntelliTeam Designer software installer is available for download at the S&C  
Automat ion Customer Suppor t Por ta l  i n the Intel l iTea m SG Sof twa re  
workspace. A password is required to access the portal, and the password can be requested 
on the login page. Go to http://sandc.com/en/contact-us/sc-customer-portal/.  
See Figure 1 on page 9.

NOTICE
Administrator privilege must be used to run the IntelliTeam Designer Setup installer 
in the Windows 10 operating system .

Download and run the IntelliTeam Designer Setup installer.

Software Installation
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The IntelliTeam Automatic Restoration System has two basic software components: 
IntelliTeam Designer configuration and license management software and the IntelliTeam 
feature license. They are licensed separately. The IntelliTeam feature license has bronze 
and gold levels for IntelliTeam SG and an IntelliTeam II license. S&C Specification 
Bulletin 1044-31 lists the features included in the license level. Every device controlled by  
IntelliTeam SG system software includes a bronze-level license. The IntelliTeam SG gold 
license and IntelliTeam II license are sold separately and must be assigned to a specific 
device. IntelliTeam Designer is provided separately and requires an IntelliTeam Designer 
slot for each device. Every device must be associated with a specific designer slot before 
it can be used in an IntelliTeam system. IntelliTeam Designer can be installed on any 
number of computers. S&C Specification Bulletin 1044-31 describes the IntelliTeam 
Designer licensing requirements.

Follow these steps to assign the designer slots and feature licenses to specific assets 
(devices):

STEP  1 .  Log in to the S&C Automation Customer Support Portal at sandc.com. If the 
user doesn’t have an account, submit a password request at the Login screen.

STEP  2 .  Select the Licensing tab to view the device assets and the available licenses.

STEP  3 .  When the necessary licenses for the devices have been obtained, contact 
sandc.com/en/contact-us/technical-support/ with “Asset Assignment 
Report” in the Subject field, and include the name of the company that owns the 
IntelliTeam system licenses in the body of the email. The reply from S&C will 
list all the company’s IntelliTeam system assets. A sample asset file is shown in 
Figure 2 on page 10.

License Management

Figure 1 .  S&C Automation Customer Support Portal Login screen .
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Figure 2 . Sample asset file .

Follow these steps to update the activation file:

STEP  1 .  For version 7.3.x.x and later: open the asset file and enter the required asset 
associations. All assets when entered in the license database are automatically 
assigned a bronze-level license and a designer slot assignment of 0. To upgrade 
an asset, change the license type to gold or IntelliTeam II (version 7.6.xx or 
later) as needed. To assign a designer slot to an asset, change the 0 to 1. A 
designer slot assignment of 1 is required for IntelliTeam Designer to recognize 
the asset for use in an IntelliTeam system.

For versions 7.1.x.x or earlier: register the computers that will use 
IntelliTeam Designer  software. Register the computer MAC address. See the 
“Computer MAC Address” section on page 12 for the procedure to determine 
the MAC address of the computer. Include the MAC address of the computer 
in the same email sent to return the updated asset file. Also include the name 
of the company that owns the IntelliTeam SG system licenses, the name of 
the primary computer user, and the computer user’s email address and phone 
number. To determine whether the computer has already been registered, 
select the Licensing tab to view a list of the authorized users registered to 
the account.

Note: IntelliTeam Designer version 7.3.x.x and later no longer requires reg-
istering the computer MAC address as long as there is a single MAC address 
registered as part of the activation file.

NOTICE
The IntelliTeam Designer license includes an IntelliLink Setup Software 
license by default . There is no need to request registration of the 
computer for the IntelliLink Setup Software .

STEP  2 .  Download and save the license activation file: ActivationFile.xml, as directed 
in the “License Activation File” section on page 13. An email notification that 
the activation file is ready will be sent. Then, log in to the S&C Automation 
Customer Support Portal account and save the Activation file. When IntelliTeam 
Designer is installed and the license activation file saved, the IntelliTeam 
system can be configured.
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An IntelliTeam Designer trial registration does not have the full-license capability to  
propagate a Netlist or collect event data for replay. Trial mode provides a library of 
pseudo serial numbers and licenses that allow building and validating IntelliTeam SG 
system configurations for training purposes.

Trial mode is ideal for training and software evaluation, and it does not require  
activation file registration. Circuit diagram configurations created with Trial mode can be  
repopulated with the serial numbers of registered products at a later date. To use  
IntelliTeam Designer Trial mode, click on the OK button in the license notification 
dialog box and click on the Yes button in the IntelliTeam Designer (Trial) dialog box. 
See Figures 3 and 4.

Trial Registration

Figure 3 . Startup licensing dialog box .

Figure 4 . IntelliTeam Designer (Trial) confirmation dialog box .
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Figure 5 . IntelliTeam Designer Start page, location of MAC address .

In the IntelliTeam Designer Start page, click on the Activate button on the left side. 
On the right side, click on the Offline Activation button to load the Offline Activation 
screen at the right, if not already shown. The MAC address is located above the Offline  
Activation button, or it can be found below the “License Information” section. See 
Figure 5.

Computer MAC 
Address

Figure 6 . IntelliTeam SG Software workspace on the S&C Automation Customer Support 
Portal .

The S&C CheckMacAddress.exe utility can also be obtained at the IntelliTeam SG 
Software workspace on the S&C Automation Customer Support Portal. See Figure 6. Save 
this utility on the computer desktop, and double click to run the utility. The computer 
MAC address required for registration will be reported by this utility.
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Go to sandc.com, click on the Support tab, and then click on the S&C Automation 
Customer Support Portal entry in the left column. Enter the username and password 
to login.

Select the Licensing tab and verify there is a valid license association and the  
correct MAC address for the computer. Select the Activation File tab. This  
generates a new activation file with the present information displayed at the Licensing 
tab. Then, a File Download dialog box will open. Click on the Save button and a Save As 
dialog box will open. Save the ActivationFile.xml on the desktop.

Note: The IntelliTeam Designer program now notifies users when the activation file is 
about to expire. This notification is displayed 30 days before the activation file expires 
and then every five days thereafter until either the activation file is updated or expires. 
When the activation file expires, a new notification will be displayed telling the user the 
activation file is now expired and needs to be updated.

Offline Activation with IntelliTeam Designer
Use the Offline Activation process to automatically place the activation file in the 
correct directory on the computer. To do so, follow these steps:

STEP  1 .  In the Start page of IntelliTeam Designer, click on the Activate button on the 
left. If IntelliTeam Designer is already open, access the Start page by clicking 
on the File tab in the top menu and then selecting the Close option. 

STEP  2 .  Click on the Offline Activation button to load the Activate Offline screen 
shown on the right in Figure 7 on page 14.

STEP  3 .  Click on the Offline Activation button on the right.

STEP  4 .  Navigate to the desktop and select the ActivationFile.xml entry to activate 
IntelliTeam Designer. IntelliTeam Designer will restart after the ActivationFile.
xml data have been successfully loaded. See Figure 7 on page 14.

License Activation File

It is not common, but sometimes a computer does not have an Ethernet adapter 
local area connection. In that case, register the wireless MAC address. If running the  
program CheckMacAddress.exe, it will report the wireless MAC address for that computer.

Registration also allows use of the USB MAC address. CheckMacAddress.exe reports 
in this order: (1) Ethernet adapter local area connection, (2) Wireless  MAC address, and 
(3) USB MAC address.
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Figure 7 . IntelliTeam Designer Start page .

Offline Activation
The activation file can also be manually saved in the following locations:

For Windows 10, save ActivationFile.xml at:

(for 32 bit) C:\Program Files\S&C Electric\IntelliLink6 and 
  C:\Program Files\S&C Electric\IntelliTeam Designer

(for 64 bit) C:\Program Files (x86)\S&C Electric\IntelliLink6 and 
  C:\Program Files (x86)\S&C Electric\IntelliTeam Designer

or if lacking Administrative Privilege, save the ActivationFile.xml file at: 
  C:\Users\username\AppData\Local\S&C Electric

If the instructions above fail to activate the software applications, delete the  
ActivationFile.xml from all existing locations on the computer and save the new 
ActivationFile.xml in the following directory: C:\Users\Public\Public Documents\S&C 
Electric.

Note: This fix only applies to Windows 10 users and is only supported by IntelliLink6 
version 608.8 and later.
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Figure 8 . IntelliTeam Designer Start Page, Online Activation Login screen .

Online Activation
The IntelliTeam Designer Online Activation function communicates with the S&C  
Automation Customer Support Portal and allows users to download and activate their  
IntelliTeam Designer application online. This significantly streamlines the activa-
tion process because once a user logs in to the portal and becomes an activated user, 
IntelliTeam Designer will download and store the activation file on the user’s computer 
with no manual intervention required. There is also an option to download the activation 
file automatically each time a user logs in to the portal, so the user is always working with 
the most recent activation file that includes all available IntelliTeam licenses and assets.

Follow these steps to use online activation:

STEP  1 .  In the IntelliTeam Designer Start Page screen, click on the Activate link on the 
left side.

STEP  2 .  On the right side of the screen, click on the Online Activation button to load 
the online activation customer portal Login screen. See Figure 8.

Note: If the Online Activation button is not displayed, go to the Start page. 
Click on the Options button on the left, click on the Configuration button, 
and put a check mark in the Online Activation box.
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Non-activated Computer
Follow these steps to get the activation file for a non-activated computer:

STEP  1 .  Enter the customer portal username and password to log in to the portal.

STEP  2 .  When logged in, the IntelliTeam Designer program will activate the MAC 
address of the computer and then automatically download the activation file to 
the computer. This will exit the Trial mode and activate IntelliTeam Designer 
so it can be used to configure the IntelliTeam system using the existing 
IntelliTeam system-enabled field devices.

STEP  3 .  To enable automatic downloads, click on the Automatically Download 
Activation File button. It will then change to “enabled” for that option.

STEP  4 .  Log out of the customer portal.

Activated Computer
Follow these steps to get the activation file for an activated computer:

STEP  1 .  Enter the customer portal username and password to log in to the portal.

STEP  2 .  When logged in, click on the Download Activation File button. This will 
download the existing activation file from the customer portal account and 
replace the one presently on the computer.

STEP  3 .  To enable automatic downloads, click on the Automatically Download 
Activation File button. It will then change to “enabled” for that option.

STEP  4 .  Log out of the customer portal.
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Check for Updates
Click on the Check for Updates button; it will check the customer portal to determine 
whether a new activation file is available with a new expiration date.

Download Activation File
Click on the Download Activation File button; it will download the existing activation 
file from the customer portal.

Note: If the computer is not activated, the IntelliTeam Designer program will not allow 
downloading the activation file. Activate the computer first before selecting the activa-
tion file download.

Deactivate/Activate Computer
Click on the Deactivate/Activate Computer button; it will either deactivate the 
computer from the customer portal (remove the MAC address) or activate the computer in 
the customer portal (add the MAC address), depending on the button display (Deactivate 
or Activate).

Note: This is no longer an option in IntelliTeam Designer version 7.3.x.x and later 
releases because the requirement to register MAC addresses has been removed in those 
releases.

Automatically Download Activation File
Click on the Automatically Download Activation File button; it will either enable or  
disable automatic downloads of the activation file upon login to the customer portal from 
the IntelliTeam Designer interface. By default, this option is disabled. When enabled, the  
IntelliTeam Designer program will automatically download and replace the activation 
file on the computer when a user logs into the customer portal. 

Online Activation 
Options
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Figure 9 . IntelliTeam Designer Start Page navigation buttons .

The first screen that appears when IntelliTeam Designer is launched is the Start page. It’s 
a quick way to preview recently opened circuits, set options, and view information about  
IntelliTeam Designer. The navigation buttons are shown in Figure 9. When IntelliTeam 
Designer is already open, access the Start page by selecting the File tab in the top menu 
and clicking on the Close button.

Start Page
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Draw Enters Draw mode and starts a new circuit

Open Circuit Opens a circuit for editing in Draw mode

Instant Replay Enters Instant Replay mode with an empty circuit

Open Replay Log Opens a replay log for viewing in Instant Replay mode

Recent Shows recently opened circuits and replay logs, allows a circuit 
to be previewed

Options Set persistent options and sound effects for Instant Replay

Activate Activates the IntelliTeam Designer application either via the 
offline or online activation processes

Help This provides an overview of What’s New (in versions 7.5.x.x 
and earlier), IntelliTeam Designer Help Documentation, and 
About IntelliTeam Designer

Exit Closes the IntelliTeam Designer program

Show Start Page 
on Startup

If checked, the Start page is the first screen to appear when 
IntelliTeam Designer is launched. If unchecked, IntelliTeam 
Designer will launch in Draw mode
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Figure 10 . IntelliTeam Designer Recent Files screen .

The Recent button allows viewing recently opened circuits and replay logs. To preview 
a circuit, click on the file name, and the circuit will be drawn in the “Circuit Preview” 
workspace. See Figure 10.

To open a circuit, double click the file name, or click on the Open File icon on the 
left side of the file name to open.

Recent Option

Open File

Depending on the file type, it will open in either 
Draw mode or Instant Replay mode. The icon 
next to the file name will indicate the mode in 
which the file would open.

Draw Mode
This icon shows the type of file in the Recent 
File list.

Instant Replay 
Mode

This icon shows the type of file in the Recent 
File list.

Pin File
Click on this button to pin a file to the list. Pinned 
files will always remain at the top of the list.

Remove File Click on this button to remove a file from the list.

Click on the Clear button at the bottom to remove all entries in the Recent Files list.

To change the number of visible items in the Recent Files list, modify the number 
listed at the Quickly access this number of documents setting.

20  S&C Instruction Sheet 1044-570

Tools and Features



The following workflow steps will help quickly build the circuit and configure the  
IntelliTeam system; save the work at any step:

STEP  1 .  Launch IntelliTeam Designer. Open a file or create a new file from the file menu.

STEP  2 .  Place the sources. See Figure 11 on page 22.

STEP  3 .  If required, place distributed generation devices (available in version 7.3.x.x 
and later). 

STEP  4 .  Place the wire-connection points.

STEP  5 .  Draw wires between sources and wire-connection points.

STEP  6 .  Place switches on the wires, and rename switches as preferred.

STEP  7 .  Establish the normal state of each switch, set the hinge side, and set sensor 
location.

STEP  8 .  Run the Validate option to automatically generate team associations.

STEP  9 .  Correct any attribute errors or warnings as necessary.

STEP  10 .  Change the default team names to the names wanted.

STEP  11 .  Save the file.

STEP  12 .  Setup attributes. 

STEP  13 .  Add any annotations such as text, lines, boxes, and images.

STEP  14 .  Toggle the “Show Wire Connections” entry in the Option menu to hide all wire 
connections.

STEP  15 .  Save the file. The IntelliTeam system configuration is complete.

Drawing Workflow
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Figure 11 . Workspace option locations .

Zoom Wheel Clicking on this icon puts the mouse wheel into 
zoom mode.

Validate Tool This icon runs a validation check of the Netlist and 
device attributes.

Communicate to 
Devices

This icon connects to an entry-point device to 
configure the IntelliTeam SG system.

Show Grid This icon toggles the drawing grid on and off. 
Objects automatically snap to the grid when this 
feature is on.

Miscellaneous Tools

Workspace

Main menu

Miscellaneous tools

Group tools

Drawing tools

Tree view

Drawing space

Component explorer

Visual properties editor

Attributes editor

Configuration display
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Drawing Tools
Select Item This icon is the item-selection tool for moving 

objects. Press and hold the <Ctrl> key to select 
multiple objects. Selected objects are bordered 
and remains selected until a place object tool is 
selected.

Pan Mode This icon allows easy panning, rather than holding 
the <Alt> key and moving the mouse. To exit pan 
mode, click the Select Item (white arrow) button 
to go back to item selection.

Repeat Insert Click once to select it. Click it a second time to 
unselect. When the Repeat Insert button is 
selected, the active object insert tool remains 
active allowing multiple inserts.

Add Source This icon places one source object in the drawing 
area unless the Repeat Insert button is selected 
to allow multiple sources to be inserted.

Show  
Full Screen

This icon toggles to hide or show the Side Bar 
and Configuration Display to allow more drawing 
space.

Undo This icon reverses the last operation, up to 100 
steps.

Redo This icon reverses the last undo, up to 100 steps.

Magnifying 
Glass

Clicking on this icon turns the mouse cursor into 
a magnifying glass. Select the zoom percentage 
using the combo box to its right. The magnifying 
glass can also be turned on by pressing the <Shift> 
key and the Left mouse button inside the circuit.

Zoom In Clicking on this icon zooms into the circuit view.

Zoom Out Clicking on this icon zooms out of the circuit view.
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Add DG Device This icon places one distributed generation (DG) 
device in the drawing area unless the Repeat 
Insert button is selected to allow multiple DG 
devices to be inserted. A DG device must be con-
nected to a single IntelliTeam SG system device, 
such as an IntelliRupter® fault interrupter, 
6800 Series switch control , 6801M switch operator, 
IntelliNode/UIM, or IntelliNode/Info-Only module.

Note: A new device has been added to  
IntelliTeam Designer called an IntelliNode/Info-
Only module, designated with an “IO #” label 
as shown in Figure 12. This device is only used 
when an IntelliNode Interface Module is installed 
as a stand-alone device in the field and is com-
municating to a DG protection device (e.g. relay, 
breaker) via DNP3 remotely. If the IntelliNode 
module is physically installed with a device, the 
traditional IntelliNode/UIM module type is used 
instead. 

An Info-Only device takes part in all normal 
team activity but cannot initiate a team transfer 
event, nor can it be selected as a switch to 
open or close during normal restoration and 
reconfiguration. Four new validation rules are used 
with an IntelliNode/Info-Only module:

• It must be connected to a DG device on one side 
and be part of a normal IntelliTeam SG system 
team on the other side.

• It cannot be excluded from the circuit.

• It cannot be a normally open device.

• It cannot be part of a closed-loop circuit.

Figure 12 . The IntelliNode/Info-Only module .

Note: The DG device and IntelliNode/Info-Only device can only be used in an Intel-
liTeam SG system using an IntelliTeam gold license. These cannot be used when using 
IntelliTeam II or IntelliTeam SG bronze licenses.
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Add Device 
Switch

IntelliRupter 
Device

This icon places one device switch object in the 
drawing area unless the Repeat Insert button is 
selected to allow multiple switches to be inserted. 
This can be dropped onto a wire and it will merge 
automatically.

T h e  I n t e l l i R u p t e r  f a u l t  i n t e r r u p t e r  i s 
the defau lt dev ice, with Y at the jaw. I f 
changing to a 6800 Series switch control or  
IntelliNode Interface Module, the X is removed 
and the voltage sensor is correctly placed on 
the jaw side by default. It is important to ensure 
the actual placement of the voltage sensor in the 
field, either jaw or hinge side, is reflected in the  
drawing of the device as this is used by IntelliTeam 
system to determine load directionality.

The default voltage sensor orientation can be 
changed by using the Toggle Terminal icon in 
the drawing area. See Figure 13.

The list of single-switch device types is: 
IntelliRupter, IntelliNode/UIM, IntelliNode/
Info -Only, PadMount Single 1V, 6801-E33, 
6801-Scada-Mate, 6801 Universal, 6801M-E33, and 
6801M. The images that represent each device type 
are shown here.

Figure 13 . The Toggle Terminal icon dialog box in the drawing area .
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Note: Wire the sources together first. When a 
switch is dropped in the middle of a wire, it auto-
matically connects itself on both sides of the wire. 
It will also automatically rotate itself to connect to 
a vertical wire.

Note: When placing a device on a vertical wire 
make sure the mouse cursor completely covers the 
wire. If the device is not placed on the wire, click 
on the Undo button and try again.

Add 2 Switch This icon adds two switches in the drawing area 
unless the Repeat Insert button is selected to 
allow multiple wires. This is to support the 6802 
control, which has two switches that share the 
same IP, RTU, and serial number data.

PadMount Dual 2V is the default. All multi-switch 
devices have been converted to this type. Other 
device types available are: PadMount Dual 1V, 
6802-OverheadST, 6802-Universal, 6802-Vista. 
These are shown in Figure 14 on page 27 and can 
be toggled in the Visual Properties area.

Note: The PadMount Dual 1V must have the sen-
sor on the internal bus. If this switch is toggled to 
change the sensor orientation where the sensor is 
facing the incoming side of the device, a valida-
tion error will occur and require the sensor to be 
placed on the internal bus in order to validate a 
circuit.

Add Wire This icon adds a wire in the drawing area unless 
the Repeat Insert button is selected to allow 
multiple wires.
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Note: Zoom in as much as possible, keeping both 
devices to be wired together on the screen. It will 
make connecting the wires easier. Close the con-
figuration dialog boxes to make the drawing area 
larger to allow a bigger zoom. 

Incremental 
Zoom

This icon allows zooming with the mouse wheel 
by selecting the Mouse Wheel Toggle button. 
Select the button again to resume normal opera-
tion. Zooming is centered at the location of the 
mouse pointer.

Add Wire  
Connection

This icon inserts a wire connection point unless 
the Repeat Insert button is selected to allow 
multiple wire connections to be inserted. A wire 
connection point is needed to electrically join two 
wires. This can be dropped onto a wire, and it will 
merge automatically like a switch. This is helpful 
to make “T” and right-angle connections.

Add Text This icon adds a text box for user defined labels.

Figure 14 . Multi-switch device types .
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Add Line This icon adds a static line to the drawing. Line 
color, thickness, and style can be changed through 
the Visual Property field after the horizontal line 
has been placed. See Figure 15.

Note: This annotation can be rotated to any 
angle. Select the line with a mouse click or 
with Component Explorer, and the rotate option 
(white circle at the top) will appear. Hover the 
cursor over the white circle until a white arc with 
two arrows appears. Left click and drag the cur-
sor left or right to rotate.

Figure 15 . Component Explorer dialog box .

Add Box This icon adds a static box to the drawing. Line 
color, thickness, and style can be changed through 
the Device Editor dialog box after the box has 
been placed.

Add Image This icon adds an image box to the drawing. To 
add an image to the drawing, click on the Add 
Image icon. Then, place it on the drawing and an 
image box will appear that looks like an S&C logo. 
Use the Browse button to locate the image file to 
be displayed in the image box. The Image Editor 
will display when an image box has been selected. 
It will be on the right side of the workspace, in 
the Visual Properties area. See the workspace in 
Figure 12 on page 24 and Figure 16 on page 29.
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Figure 16 . The Visual Properties dialog box .

Rotate Switch or 
Source

Click on the Rotate Switch or Source tool to select 
it. The tool remains selected until clicked a second 
time. Click on a device to rotate it. Only the connec-
tion handles are affected by the rotate operation 
when applied to a source.

Toggle Switch 
Open/Close

This tool is used to set the normal state of all 
switching devices in the drawing. It has no effect 
on a source. This tool remains selected until it has 
been unselected by clicking it a second time.

Note: Set all normally open devices before run-
ning the Validate function to avoid unnecessary 
errors.
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● Sensor locations entered on the IntelliTeam Designer diagram are now automatically configured in the 
controls . This means it is necessary to have an accurate representation of sensor locations in the IntelliTeam 
Designer diagram . For the devices in the field, there is only one requirement for a specific sensor location, 
so it can always detect source voltage and the normal current flow is from the sensor side of the switch to the 
non-sensor side of the switch . The first device outside the substation must have its sensors on the substa-
tion side when the substation breaker is not a team member . The Toggle Terminal tool allows creation of an 
accurate representation of the system, but these settings must be configured at each device .

■ To have IntelliTeam Designer remember the device attributes of an excluded device, the circuit must be 
validated and saved before exiting the application . Then, when the device is re-included, IntelliTeam Designer 
will populate the saved device attributes . If the excluded device is a two-switch device, it will be reverted to a 
PadMount device, so if it is any other type of two-switch device, it will then need to be modified in the Visual 
Properties area .

Toggle Terminal This icon flips the 1 and 2 terminal designations 
shown on the diagram for a switch. The device 
sensor terminal relation will remain the same and 
the sensor will follow the terminal as it is moved. 
For IntelliRupter fault interrupters, Terminal 1 = 
the X terminal, and Terminal 2 = the Y terminal. 
This tool remains selected until it has been 
unselected by clicking it a second time.●

The Y terminal follows the Jaw side for an 
IntelliRupter fault interrupter, and the sensor 
follows the Jaw side for a 6800 Series switch.

Exclude/Include This icon converts a switch to a wire, or it converts 
a source to an end load and removes the switch 
from the team. It can be used for drawing manually 
operated switches in pad-mounted gear.

For an IntelliRupter fault interrupter the X and Y 
terminal designations are removed, but IntelliTeam 
Designer remembers them if the IntelliRupter fault 
interrupter is subsequently included.■ 

Exclude/Include 
Open

This icon converts a switch to an open manual 
switch and removes the switch from the team. 
It can be used for drawing manually operated 
switches in pad-mounted gear.

For an IntelliRupter fault interrupter the X and Y 
terminal designations are removed, but IntelliTeam 
Designer remembers them if the IntelliRupter fault 
interrupter is subsequently included.■
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File Menu

Figure 17 . Selections available under the Recent Files menu .

File > New When selected, IntelliTeam Designer clears the circuit 
diagram but does not exit the application.

File > Open When selected, a file prompt will appear to select a circuit 
to open.

File > Recent 
Files 

This menu contains a list of recently opened files. Recent files 
are added to the top of the list and will remove the oldest file 
if it exceeded the list limit. Clicking on the file will open the  
circuit. Clicking on the pin will keep the file at the top and 
will not remove it from the list even if the list exceeds the 
limit. Clicking on the X button will remove it from the list. See  
Figure 17.

Delete Item This icon deletes one item at a time. Select the tool 
and click on a switch or source to delete. Double 
click a wire to delete it. This tool remains selected 
until it has been unselected by clicking it a second 
time.

Disconnect Item This icon disconnects an item from the wire. Select 
the tool and click on a switch, wire connection, or 
source to disconnect it from the wire. This tool 
remains selected until a different tool is selected.
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File > Close When selected, IntelliTeam Designer clears the circuit 
diagram and enters the Start page.

File > Save When selected, IntelliTeam Designer saves the circuit to a 
file. If a circuit is opened, it will overwrite it. Otherwise, it 
will prompt for a new file name.

File > Save As When selected, IntelliTeam Designer saves the circuit to a 
file. It will always prompt for a new file name.

File > Save As 
Image...

This menu saves the circuit diagram in a different image 
format, such as pdf, svg, wmf, gif, jpg, tif, and png.

File > Exit When selected, it will close IntelliTeam Designer.

System Menu This contains all menu options related to database access and is only available for 
users who have that access as part of their activation file. See Figure 18.

Figure 18 . The System menu .
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Edit Menu Edit > Find When selected, it opens a floating dialog box for finding 
objects in the circuit.

Edit > Undo When selected, this reverses the last operation, up to 100 
steps.

Edit > Redo When selected, this reverses the last undo, up to 100 steps.

Edit > Select All When selected, this selects all drawing items so they can be 
edited together.

Circuit Menu
Circuit > Print 
Preview

When selected, a new pop-up screen will be displayed asking 
which page size should be used. Options are 8.5x11, Plotter 
B (11x17), Plotter C (17x22), Plotter D (22x34) and Plotter E 
(34x48). When a page size is selected, a print dialog box will 
open and show the current drawing. Print the image, zoom in 
or out, and preview the different pages that will be printed.

Circuit > Print 
Landscape

When selected, this will make the circuit image print in  
landscape format instead of portrait format. 

Circuit >  
Zoom In

When clicked on, this will zoom in on the existing circuit  
drawing.

Circuit >  
Zoom Out

When clicked on, this will zoom out on the existing circuit 
drawing.

Circuit >  
Validate

When clicked on, this will attempt to validate the existing 
circuit drawing.

Circuit >  
Auto Validate 
On Open

When selected, this will automatically validate the existing 
circuit when it is re-opened in IntelliTeam Designer.

Circuit >  
Auto Validate 
On Save

When selected, this will automatically validate the existing 
circuit when the circuit is saved in IntelliTeam Designer.

Circuit >  
Validate  
Unique IP

When selected, this will verify all devices have a unique IP 
address configured on the existing circuit.

Communication 
to Devices

When selected, this will launch the communication manager 
in IntelliTeam Designer.
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All menu options are remembered for the next IntelliTeam Designer session except 
where explicitly specified that it is not remembered.

Show Full 
Screen

When selected, the other sections are collapsed to fully 
expand the diagram. This option is not remembered.

Show Grid When selected, it shows the grid points on the screen.

Show Classic 
Background

When selected, it changes the diagram background color 
to light gray. When not selected, the background color is 
slate gray.

Show Wire  
Connection

When selected, it shows a black dot in the diagram to rep-
resent a wire connection.

Align Wire to 
Grid

When selected, it snaps objects to the grid points.

Options Menu

Align Top This icon brings the top of all selected objects up to 
the top of the highest object in the selected group.

Align Left This icon brings the left side of all selected objects 
to the left side of the far left object in the selected 
group.

Align Bottom This icon brings the bottom of all selected objects 
down to the bottom of the lowest object in the 
selected group.

Align Right This icon brings the right side of all selected 
objects to the right side of the far right object in 
the selected group.

Space  
Horizontally

This icon spaces all selected objects evenly 
between the right and left object of the selected 
group.

Space 
Vertically

This icon spaces all of the selected objects evenly 
between the highest and lowest of the selected 
objects.

Group Delete This icon deletes all of the selected objects.

Group Tools
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Figure 19 . Standard drawing with default color scheme for switches .

Figure 20 . Reversed switch color scheme .

Component 
Explorer Center 
Selection

When selected, it centers on the object that is selected in 
the Component Explorer.

Show Replay 
Pointers

When selected, pointers will appear during the Instant Replay 
session to highlight which devices operated. This is only  
available in the Instant Replay mode.

Reverse Switch 
Colors

When selected, it converts drawing colors to the reverse 
standard, from red closed switch to green closed switch. 
See Figures 19 and 20.

Auto Refresh 
Labels at  
Validation

When selected, it automatically enables the labels for 
switches and sources if the labels have data (such as RTU 
for a switch).

Show Anchor 
Markers

When selected, it shows small circles where a wire can be 
connected to the circuit object.

Prompt for Swap 
Switch Positions

When the Add 2 Switch button is used to create a switch 
pair, this option swaps the Switch 1 and Switch 2 names. 
See Figures 21, 22, and 23 on page 36.

Clicking the menu item will swap the switch positions even 
after insertion. The Swap Switch Positions command is 
also available as a right-click option.
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Figure 21 . Options Menu: Prompt for Swap Switch Positions dialog box .

Figure 22 . Switch positions before they are swapped .

Figure 23 . Switch positions after being swapped .
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Propagation  
Version

This option, for version 7.1.x of IntelliTeam Designer, is 
called “New Propagation Version” and is enabled by default. 
This is used by device firmware version 7.1.x to push the 
Netlists to the controls. If the controls are using an older 
version of software, disable this by unchecking it.

For the 7.3.x version of IntelliTeam Designer, this now 
has three options; 6.3 and earlier, 7.1, and 7.3 (selected by 
default). To push a Netlist, make sure the devices are all 
running the same firmware version. This option must be 
configured to match that firmware version. If they do not 
match, an error will be seen during a Netlist push indicating 
there is a mismatch.

Note: This option has been removed in IntelliTeam 
Designer version 7.5.x and later. Version 7.5.x and later 
will automatically detect which firmware version the 
devices are running when using the communication  
manager and running a communications check, then the 
appropriate Netlist will be pushed to the devices.

IntelliTeam II 
Setpoint 
Configuration

This option, for version 7.5.x of IntelliTeam Designer 
and later, puts the IntelliTeam Designer application into 
IntelliTeam II Setpoint Configuration mode where it 
will generate IntelliLink® Setup Software .xspt configura-
tion files that can either be pushed to the devices by the 
communication manager in IntelliTeam Designer or can be 
programmed into the devices using the IntelliLink Setup 
Software application. 

This option is disabled by default and supports firmware 
versions 6.1, 6.3, 7.1, 7.3, 7.4, 7.5, and 7.6. IntelliLink 
setpoint files will be saved in the same directory where 
the IntelliTeam Designer circuit is saved on the computer’s 
hard drive.

Note: When this option is enabled and a circuit is drawn, 
it must be saved first before the setpoint files will be  
generated. Also, The IntelliTeam Options Enabled  
setting in the Team Attributes tab and Substation 
Team Attributes tab must be set to ITII mode to gener-
ate the setpoint files or validation errors will occur. 

Enable  
IntelliTeam 
FMS Export

When selected, it enables the IntelliTeam® FMS Feeder 
Management System export.
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Side Bar Pin These pins are located on the upper right of each dialog 
box. They pin and unpin the dialog box containing the 
Component Explorer, the Visual Property Editor, the Tree 
View, or the Configuration Display. See Figures 24, 25, and 
26 on page 39.

Note: When the Component Explorer Center Selection 
entry is checked in the Options menu, the object selected 
in the Component Explorer is moved to the center of the 
drawing area. Use this feature to view a specific device 
after the zoom function has placed it off screen.

Note: Large zoom changes may result in an empty draw-
ing dialog box. Use the Component Explorer to bring the 
drawing objects back into the dialog box.

Note: Selecting a device in the Component Explorer popu-
lates the device attributes in the Visual Property dialog 
box.

Pinned Dialog Boxes

Enable Sound 
Effects

When selected, it turns on sound effects for Instant Replay 
events. Only available in the Instant Replay mode.

Show Admin 
Options

When selected, this shows the administrator options in the 
System menu that allow an administrator to manage users. 

Show  
Notification 
Timestamps

When selected, this shows timestamps for all Error states,  
Warning states, and informational notifications that occur 
within the application.

Show Error  
Notifications

When selected, this shows error notifications in the applica-
tion when Error states occur.

Show Warning 
Notifications

When selected, this shows warning notifications within the 
application when Warning states occur.

Show Info  
Notifications

When selected, this shows information notifications within 
the application as they occur.
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Figure 24 . The Component Explorer dialog box .

Figure 25 . The Visual Properties dialog box .

Figure 26 . The Tree View dialog box .
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Figure 28 . Find Item as a floating dialog box .

The Component Explorer, Visual Properties, Tree View, and Find Item dialog boxes can 
be dragged from their anchor position and become floating dialog boxes. To make it a 
floating dialog box, click and hold the title and drag it away from the anchor position. To 
re-anchor the dialog box, click and hold the dialog box’s title and drag it back into the 
anchor position. See Figures 27 and 28.

Floating Dialog Boxes

Figure 27 .  Component Explorer as a floating dialog box .
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Configuration 
Display Pin and 
Tab

The pin is located on the lower right of the workspace. This 
hides the configuration display or pins it to remain shown.

When the configuration display is hidden, the  tab is the only 
one shown on screen. Hovering over or clicking on it will show 
the configuration display until the mouse is moved away from 
the tab and click on other pins. See Figure 29.

Configuration Display

Figure 29 . Configuration display .

Figure 30 . The Circuit Errors or Warnings dialog box .

The Configuration Display area will show a green check mark with 0 Errors and  
0 Warnings if the circuit is valid and no validation errors or warnings occur when a circuit 
is validated. If there are errors or warnings, a message will open along with notes in the 
Description area explaining why errors or warnings occurred. See Figure 30.

Validation Errors and 
Warnings
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This tab contains the Device ID, RTU, IP, Serial Number, and CEC Allowed attributes. 
A field can be sorted by clicking a column header. The first click sorts ascending and 
the  second click sorts descending. All Attributes tab fields can be sorted. The values 
may be edited directly in the table or in the side panel configuration area.

Device ID Device identification, automatically assigned when a device is 
placed in the schematic, user configurable and must be unique

RTU The DNP address for the device; a unique DNP address must 
be supplied for each device

IP The IP address for the device; only required when Ethernet 
communication is used with the device

Serial Number The device serial number; only serial numbers that are  
contained in the license Activation File can be used

CEC Allowed True—Enables communication-enhanced coordination (CEC) 
for an IntelliRupter fault interrupter (It is only applicable 
for an IntelliRupter fault interrupter. CEC only functions 
in systems with IntelliRupter fault interrupters or with an 
IntelliRupter fault interrupter or a substation IntelliNode 
Interface Module or 6800 Series control as the head end device. 
It does not work in systems with 6800 Series controls or  
IntelliNode modules alone or in situations where there is more 
than one IntelliNode module or 6800 Series control in front 
of the first IntelliRupter fault interrupter where CEC will be 
used or if there are IntelliNode modules or 6800 Series controls 
between IntelliRupter fault interrupters.

False (default)—Disables CEC

Note: IntelliTeam Designer uses the X (red terminal 1) and 
Y (blue terminal 2) bushings for CEC, so these must be setup 
in the application exactly how the IntelliRupter fault inter-
rupter is set up in the field.

Device Attributes Tab
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Contains the Switch Team ID, Team Record Number, Alternate Sources, Line  
Segment Limit, Contracts Required, Return to Normal Time, Prohibit Restoration Time, 
IntelliTeam Options Enabled, and Load Priority attributes. A field can be sorted by  
clicking a column header. The first click sorts ascending and the second click sorts 
descending. All Attributes tab fields can be sorted. The values may be edited directly 
in the table or in the side panel configuration area. See Figure 31.

Team ID Automatically populated when a Validate operation is run 
(This is the designation used by the IntelliTeam SG system to 
identify each line segment bounded by IntelliTeam SG system 
devices.)

Team Number Automatically populated when a Validate operation is 
run (Each team number is listed in the table shown on 
the IntelliTeam>Operation>Team Summary, and the 
IntelliTeam>Setup>Team Summary screens. The row for 
each team number shows the devices that belong to that 
team. A device can be a member of more than one team. Also, 
IntelliTeam Designer only uses eight team numbers, so these 
may be repeated on large circuits. Therefore, the team ID and 
team number make-up the team identifier.)

Note: When selecting the Team ID in the Configuration 
dialog box, the team ID (T1) and all team members (DS2, 
DS3, and DS4) are highlighted on the circuit shown in the 
workspace. See Figure 29 on page 41.

Team Attributes Tab

Figure 31 . Team Attributes tab in the Configuration dialog box .
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Line Segment 
Limit

User Setting—The default setting is N/A, which allows 
picking up as many line segments as capacity allows. Set this 
to the maximum number of line segments this team can pick 
up. For example, Add 1 inhibits any other line segments from 
being restored through a member after it restores its first line 
segment. 

To allow the team to pick up as many line segments 
as capacity allows, set this value to N/A . This setting 
is only used when the IntelliTeam SG system uses the  
IntelliTeam II logic to restore line segments.

Alternate 
Source

User Setting—The default is none. Set the priorities for 
the different ways the team members can restore a line  
segment. If the team cannot use the source, designated as 
“Source” by IntelliTeam Designer, to restore the line segment, 
then the team tries the members configured in these setpoints.

If these setpoints are not configured, or if the selected 
team members cannot be used to restore the segment,  
the team first tries the members IntelliTeam Designer 
designates as “Tie” to find an alternate source. If that is  
not successful, the team tries the members IntelliTeam 
Designer designates as “Load Tie.”

Each team can have up to four alternate sources prioritized. 
The first alternate source will be tried first and the fourth 
alternate source will be tried last, if all four alternate sources 
are populated. To set alternate source priorities, select the 
team by highlighting it in the Team ID column, and select a Rec 
number from the pull down box next to each alternate source. 

The Rec number is automatically assigned to each team 
member by IntelliTeam Designer and will have the appropriate 
team member associated with it. To see the device association, 
use the pull-down menu located below the Team Attribute 
Editor label, and hover the mouse cursor over the pull-down 
box to display the record association.

Note: Alternative source selection is only applicable when 
the IntelliTeam system uses IntelliTeam II logic to restore 
line segments. It will not be used by the Rapid Self-healing 
(RSH) logic because that logic will find a source that can 
restore all line segments through a “Tie” point.
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Contracts 
Required

User Setting—The default setting is No, which does not use 
contracts. If a circuit is bifurcated, multiple events can result 
in an overload if contracts are not used. To avoid overloading 
on bifurcated circuits, set this to a Yes value. 

When team members encounter a l ine segment in 
a restoration path that requires a contract, they will 
communicate with all subsequent line segments in the 
direction of the alternate source to ensure that the alter-
nate source will not be overloaded. This also slows down 
the reconfiguration process. Contracts are only used when  
the IntelliTeam SG system uses IntelliTeam II logic to restore 
line segments.

Return to  
Normal Time 
(mins)

User Setting—This setting is the amount of time, in minutes, 
that power must be restored to the faulted line segment before 
the Return to Normal process will start. Range: 1 to 254 
minutes; Default: 5 minutes.

Prohibit  
Restoration 
Time (mins)

User Setting—The default setting is 0, and the IntelliTeam SG 
system continues to look for a restoration solution indefinitely. 
Set this value to the length of time desired to allow this team 
to attempt to restore service after an event has begun. If this 
timer expires before restoration of service, the team will enter 
the Prohibit Restoration state, preventing any further res-
toration activity by this team until the Prohibit Restoration 
state is cleared through the appropriate SCADA command or 
on the Operation screen in the IntelliLink Setup Software by 
enabling the IT SG Restoration button.
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IntelliTeam 
Options 
Enabled

User Setting—The default is ITSG.

Disabled—All IntelliTeam functionality is turned off and 
disabled

ITII—Puts the selected dev ice in Intel l iTeam II 
Compatibility mode (This setting is used when setting up a 
device to operate in an IntelliTeam II system with 5800 Series 
Automatic Switch Controls. All devices in a given circuit must 
be using IntelliTeam II Compatibility mode for this option 
to be used.)

Note: IntelliTeam Designer cannot push settings to a 5800 
Series Automatic Switch Control. These controls need to be 
configured using the IntelliLink Setup Software. Also, this 
mode is not compatible with distributed generation and cannot 
be used when there are distributed generation devices on the 
circuit.

Note: To configure the system in IntelliTeam II 
Compatibility mode without runners using Intel-
liTeam Desinger version 7.1.x - 7.3.x, (i.e. legacy  
IntelliTeam II mode with only coach traffic), the Clear 
Feedernets button in the communication manager must be 
clicked on after the Netlists have been successfully pushed 
to all of the team devices. 

To verify a system is in this mode of operation, go 
to the Historic Log in the IntelliLink Setup Software 
and verify ITII mode is in the Active state. Otherwise, 
this mode uses runners and will increase traffic on the 
communications system unnecessarily. Refer to S&C 
Instruction Sheet 1044-577, “Intell iTeam® Designer:  
IntelliTeam® II Setup and Configuration,” for more informa-
tion about IntelliTeam II Compatibility mode of operation.

Note: To configure the system in IntelliTeam II mode using 
IntelliLink Setup Software setpoint files, all devices must 
be configured with the IntelliTeam Options Enabled set-
ting in ITII mode. Refer to S&C Instruction Sheet 1044-577, 
“IntelliTeam Designer: IntelliTeam II Setup and Configura-
tion,” for more information.
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ITSG—Puts the selected device in IntelliTeam SG mode, 
with Rapid Self-Healing mode turned off (This mode uses 
IntelliTeam II-system style restoration and has both runners 
and coaches being used.)

Note: This mode is not compatible with 5800 Series Automatic 
Switch Controls, but it is compatible with distributed genera-
tion devices on the circuit.

ITSGwRapidSelfHealing—Puts the selected device 
in IntelliTeam SG  mode with Rapid Self-Healing 
mode tur ned on (Rapid Sel f-Heal ing  mode must 
be turned on to enable the Post Restoration Load  
Management mode.)

Note: This mode is compatible with distributed generation 
devices on the circuit.

ITSGwPLIsolation—Puts the selected device in IntelliTeam 
SG mode with Phase Loss Isolation mode enabled (Phase-
loss isolation looks for a loss of phase voltage and will then 
isolate the effected teams and restore around them as neces-
sary. This option can only be used with devices that support 
three-phase voltage sensing.) 

Note: This mode is compatible with distributed generation 
devices on the circuit.

ITSGwRapidSelfHealingAndPLIsolation—Puts the 
selected device in IntelliTeam SG mode with Rapid Self-
Healing and Phase Loss Isolation modes turned on (This 
option can only be used with devices that support three-phase 
voltage sensing. Refer to S&C Instruction Sheet 1044-575, 
“IntelliTeam® Designer: Phase-Loss Isolation,” for more 
information on phase loss isolation.)

Note: This mode is compatible with distributed generation 
devices on the circuit.
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Load Priority User Setting—The default is Priority1_No Transfer.

Priority1_No Transfer—Load shedding or transferring not 
allowed

Priority3_Open Transfer—Load shedding not allowed (Load 
transfer is allowed through an open transition only.)

Priority4_Transfer Shedding—Load shedding allowed (Only 
shed after transfers to other circuits have been considered. 
Priority 4 is the highest priority of this category.)

Priority5_Transfer Shedding—Load shedding allowed (Only 
shed after transfers to other circuits have been considered.)

Priority6_Transfer Shedding—Load shedding allowed (Only 
shed after transfers to other circuits have been considered.)

Priority7_Transfer Shedding—Load shedding allowed (Only 
shed after transfers to other circuits have been considered. 
Priority 7 is the lowest priority of this category and will be 
transferred or shed before Priority 6, 5, 4, etc.)

Priority8_Shedding—Load shedding allowed (Shed these 
loads before considering load transfers to other circuits. 
Priority 8 is the highest priority of this category.)

Priority9-19_Shedding—Load shedding allowed (Shed these 
loads before considering load transfers to other circuits.)

Priority20-25_Shed and Do Not Restore Load—Priority 25 
is the lowest priority of this category and will be shed before 
any others.

Any load configured with a priority of 20-25 will be shed 
and will not be restored until the circuit returns to normal. 
These shall only be used when there is a self-tie in the circuit 
and shall only be used on loads that are in the self-tie area. 
See Figure 32 on page 49.

Note: Using a load priority of 20-25 in a non-self-tie circuit 
will result in those teams not getting restored. To correct 
a mis-configuration, the load priorities must be configured 
with a different load priority (1-19) and the Netlist must be 
re-pushed to the devices.
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Team Member 
Attributes Tab

Team ID Automatically populated by running the Validate function; 
provides a unique designation used by the IntelliTeam SG 
system to identify each line segment bounded by IntelliTeam 
SG devices

Note: If loads that were shed busing PRLM are brought back 
online manually and the circuit has not been returned to 
normal, then the loads may be restored in subsequent events 
and will not be shed again. This is a known limitation of the 
PRLM logic. To shed these loads again, they must be shed 
manually.

Figure 32 . Self-tie example diagram .
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Device ID Automatically populated when a device is placed in the 
drawing environment (Provides a unique designation used 
by the IntelliTeam SG system to identify each IntelliTeam SG 
device. The text can be modified but is limited to approxi-
mately six characters, and each ID must be unique. A text label 
placed with the Add Text tool is the recommended method for 
applying user specific labels to each device.)

Switch Position 
Number

User Setting—The default setting is Sw1. This field sets the 
switch ID for controls capable of controlling multiple switches 
under one RTU address. The setting for a single switch is Sw1.

Maximum  
Capacity (amps)

User Setting—The default setting is 600. This field sets the 
maximum amount of load each device is allowed to carry. It 
should be set to the maximum rating of the switching device 
or the maximum amount of load the switch device is allowed 
to source, whichever is lower. Make sure to take into account 
cable/wire size and any other circuit restrictions.

Also take into consideration the Substation Maximum 
Capacity setpoint because these two settings are used to  
determine how much load can be restored during an event.

Note: When using the Post Restoration Load Manage-
ment feature and enabling the Restore to Max Capacity 
Plus Overload option, the Overload Permitted setpoint 
is added to the switch’s Maximum Capacity setpoint as 
the new maximum capacity the switch can carry. There-
fore, careful consideration should be taken when using that 
option if there are switches in the system that have lower 
maximum capacity values than what is being used at the 
substation.

Return to 
Normal Mode 
(mins)

User Setting—The default setting is None, which means 
Return to Normal mode is disabled. This attribute deter-
mines the switching transition used by the Return to Normal 
mode. When enabled, the team members will return the circuit 
to its normal configuration when power is restored to the 
faulted line segment. 

For teams with one or more tie switches, choose the Open 
Transition mode, in which the tie switch(es) open before 
the other team members return the circuit to its normal con-
figuration, or the Closed Transition mode, where the team 
members close all of the switches and then the tie switch(es) 
open. The Return to Normal process starts at the line 
sections closest to the normal source, then works outward. A 
single team member should have the same Return to Normal 
mode for each team where it is a member; however, a team 
may end up with members with different modes.
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Normal Switch 
Function

This definition states the role or function each switching 
device performs relative to its team. This setpoint is automati-
cally populated when the Validate function is run. There are 
six possible designations:

SourceSub—Assigned to the source device when it is the 
first team out of the substation or it is a IntelliNode Interface 
Module on a substation breaker

SourceLoadTie—Assigned to all switches in a closed-loop 
system because they are all tied to the sources on the closed 
loop

Source—Assigned to the normally closed device that provides 
power to the line segment when the team is in its normal 
configuration

LoadTie—A team may have zero to seven closed switches 
through which loads on other line segments receive power. 
This value is assigned when the switch could be involved in 
restoring power to the line segment because line segments on 
the other side of the switch have alternate sources.

Load—A team may have zero to seven closed switches 
through which loads on other line segments receive power. 
This value is assigned when the switch could not be involved 
in restoring power to the line segment because line segments 
on the other side of the switch have no alternate sources.

TieSub—Assigned when the tie switch is the first team 
member after the substation source (A TieSub switch should 
have its voltage sensors facing the alternate source.)

Tie—Assigned to open switches in the team that restore 
power to the line segment directly from an alternate source 
when closed (A team may have zero to seven open switches.)

A team may have eight members. One Source or SourceSub 
and zero to seven in any combination of the other functional 
types.

InfoOnly—Assigned to an IntelliNode/InfoOnly device only 
(An Info Only device takes part in all normal team activity but 
cannot initiate a team transfer event, nor can it be selected 
as a switch to open or close during normal restoration and 
reconfiguration.)
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Team Customer 
Counts

This setting adds customer counts to each team that will be used by the IntelliTeam 
FMS Feeder Management System for reliability calculations (e.g. CAIDI, CMI, etc.). Six 
fields can be configured: Residential, Commercial, Industrial, Other 1, Other 2, and 
Other 3. The default entry is 0, but the default entries can be modified in the Start-up 
menu under Options>Customer Counts, shown in Figure 33.

Residential This is the number of residential customers within the team. 
(Range: 0-100,000, Default: 0)

Commercial This is the number of commercial customers within the team. 
(Range: 0-100,000, Default: 0)

Industrial This is the number of industrial customers within the team. 
(Range: 0-100,000, Default: 0)

Other 1 This is the number of type 1 other customers within the team. 
(Range: 0-100,000, Default: 0)

Other 2 This is the number of type 2 other customers within the team. 
(Range: 0-100,000, Default: 0)

Other 3 This is the number of type 3 other customers within the team. 
(Range: 0-100,000, Default: 0)

Figure 33 . The start-up menu Options>Customer Counts section .
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Substation Attributes 
Tab

Substation ID Automatically populated by running the Validate function 
(Provides a unique designation used by IntelliTeam SG system 
to identify each substation.)

Set Max 
Capacity As 
Disabled

Disables the Max Capacity setting for the selected source 
(When this check box is checked, the IntelliTeam system will 
use the calculated local capacity of first switch outside of the 
selected source (e.g., SourceSub or TieSub device) when it 
needs to restore loads.)

Maximum 
Capacity (amps)

The maximum source capacity threshold defined as the 
maximum load a source can carry before it is considered to 
be an overload condition (This will be disabled if the Set Max 
Capacity as Disabled check box is checked.)

Note: This setting must be used with the Default 
Source Segment Loading setting found on the 
Setup>Restoration>IntelliTeam SG>External Loading 
screen in the IntelliLink Setup Software. Both settings must 
be enabled for the IntelliTeam system to calculate the proper 
available capacity of a given source.

Note: When using the Post Restoration Load Manage-
ment feature and enabling the Restore to Max Capacity 
Plus Overload option, the Overload Permitted setpoint 
is added to the switch’s Maximum Capacity setpoint as 
the new maximum capacity the switch can carry. There-
fore, careful consideration should be taken when using that 
option if there are switches in the system that have lower 
maximum capacity values than what is being used at the 
substation.

Post 
Restoration 
Load  
Management 
Timers

These timers allow users to configure the IntelliTeam SG 
system to allow temporary overloads during post-restoration 
load management (PRLM). They also add flexibility to the 
overall PRLM process in terms of when the load shedding 
events should occur during an overload condition. This feature 
is only available with IntelliTeam SG 6.1 firmware and later 
versions.

Overload  
Permitted 
(amps)

This value is added to the Maximum Source Capacity  
threshold and becomes the new maximum load threshold that, 
when exceeded, requires immediate load shedding using post-  
restoration load management when the Time Overload  
Permitted timer expires.

Time Overload  
Permitted (min)

This is the amount of time that an Overload Permitted condi-
tion is allowed to exist before shedding load to the Maximum 
Source Capacity threshold.
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Substation 
Team ID

Automatically populated by running the Validate function; 
provides a unique designation used by IntelliTeam SG system 
to identify each sub team

IntelliTeam 
Options Enabled

User Setting—The default is ITSG. This setting must be set 
to the same setting that all of the team members are set to in 
the Team Attributes tab.

Disabled—All IntelliTeam functionality is turned off and 
disabled.

ITII—Puts the selected dev ice in Intel l iTeam II 
Compatibility mode (This setting is used when setting up a 
device to operate in an IntelliTeam II system with 5800 Series 
Automatic Switch Controls. All devices in a given circuit must 
be using IntelliTeam II Compatibility mode for this option 
to be used.)

Note: IntelliTeam Designer cannot push settings to a 5800 
Series Automatic Switch Control. These controls must be con-
figured using the IntelliLink Setup Software. Also, this mode is 
not compatible with distributed generation and cannot be used 
when there are distributed generation devices on the circuit.

Note: To configure the system in IntelliTeam II  
Compatibility mode without runners using Intel-
liTeam Desinger version 7.1.x - 7.3.x, (i.e. legacy  
IntelliTeam II mode with only coach traffic), the Clear 
Feedernets button in the communication manager must be 
clicked after the Netlists have been successfully pushed to 
all of the team devices. 

To ver i f y  a  sys tem i s  i n  t h i s  mode of  oper a -
tion, go to the Historic Log in the IntelliLink Setup 
Software and verify ITII mode is in the Active state.  
Otherwise, this mode uses runners and will increase traffic 
on the communications system unnecessarily. Refer to 
S&C Instruction Sheet 1044-577, “IntelliTeam® Designer:  
IntelliTeam® II Setup and Configuration,” for more informa-
tion about IntelliTeam II Compatibility mode of operation.

Substation Team 
Attributes Tab

Overload  
Qualification 
Time (sec)

This is the amount of time an overload must be present 
to be considered qualified and Post-Restoration Load 
Management logic will begin.

Enable/Disable 
Restore to Max 
Capacity Plus 
Overload

Enables/disables restoring load up to the source maximum 
capacity plus the overload permitted during an IntelliTeam 
SG system restoration event (When this check box is checked, 
this option is enabled and will restore load up to the source 
maximum capacity plus the overload permitted.)
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Note: To configure the system in IntelliTeam II mode 
using IntelliLink Setup Software setpoint files, all devices 
must be configured with the IntelliTeam Options Enabled 
setting in ITII mode. Refer to S&C Instruction Sheet 1044-
577, “IntelliTeam Designer: IntelliTeam II Setup and Con-
figuration,” for more information.

ITSG—Puts the selected device in IntelliTeam SG mode, 
with Rapid Self-Healing mode turned off (This mode uses  
IntelliTeam II system style restoration and has both runners 
and coaches being used.)

Note: This mode is not compatible with 5800 Series Automatic 
Switch Controls but it is compatible with distributed genera-
tion devices on the circuit.

I T S G w R a p i d S e l f H e a l i n g — P u t s  t h e  s e l e c t e d 
d e v i c e  i n  I n t e l l iTe a m  S G  m o d e  w i t h  R a p i d 
Sel f-Hea l i ng  mode t u r ned on (R apid sel f -hea l -
ing must be turned on to enable post-restoration load  
management.)

Note: This mode is compatible with distributed generation 
devices on the circuit.

ITSGwPLIsolation—Puts the selected device in IntelliTeam 
SG mode with Phase-Loss Isolation mode enabled (Phase-
loss isolation looks for a loss of phase voltage and will then 
isolate the effected teams and restore around them as neces-
sary. This option can only be used with devices that support 
three-phase voltage sensing.)

Note: This mode is compatible with distributed generation 
devices on the circuit.

ITSGwRapidSelfHealingAndPLIsolation—Puts the 
selected device in IntelliTeam SG mode with Rapid Self-
Healing and Phase Loss Isolation modes turned on (This 
option can only be used with devices that support three-phase 
voltage sensing. Refer to S&C Instruction Sheet 1044-575, 
“IntelliTeam® Designer: Phase-Loss Isolation,” for more 
information on phase-loss isolation.)

Note: This mode is compatible with distributed generation 
devices on the circuit.
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Distributed Generation 
Attributes Tab

Distributed 
Generation ID

This is automatically populated by running the Validate 
command. It provides a unique designation used by the 
IntelliTeam SG system to identify each distributed generation 
team. See Figure 34.

Figure 34 . The Distributed Generation Attributes Tab .

Note: If this value is set to a non-zero value, the IntelliTeam 
system will use this value to determine the amount of 
current flowing into the distributed generation team, even 
when a device teamed with the distributed generation device  
measures current coming from the distributed generation 
device. Therefore, this should only be used in cases where no 
real-time loading information is available from the distributed 
generation device when using an IntelliNode/Info-Only device.

Default Load 
Contribution

This setting should only be used when no real-time loading 
data are available from a distributed generation device. When 
set to a non-zero value, the IntelliTeam system uses this as 
the amount of current flowing from the distributed generation 
device into the distributed generation team. 

When set to zero (the default), the IntelliTeam system uses 
loading polled by the IntelliNode/Info-Only module from the 
distributed generation device as the current it’s contributing 
to the distributed generation team. But if a normal IntelliTeam 
system device is teamed with the distributed generation 
device, it will assume there is zero amps flowing into the 
distributed generation team from the distributed generation 
device when this value is set to zero. The distributed gen-
eration team load will then be calculated by the IntelliTeam 
system device by using the current flow measured by that 
device. (Range: 0–1000 A; Default = 0, meaning this is disabled 
and not used by the IntelliTeam system.)

First Device  
In Sub

Checked (True)

The IntelliNode module is installed on the substation breaker, 
or an IntelliRupter fault interrupter is used as the substation 
breaker.

Unchecked (False)

The first IntelliTeam system device is outside the substation.
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DG Reconnect 
Delay Timer

This is the amount of time delay that occurs to recon-
nect the distributed generation device back to the grid, 
when the Return to Normal (RTN) process is complete. 
When this setpoint is a non-zero value and the Transfer 
Trip Prohibit Restoration (TTPR) mode on the device is 
enabled, after the normal source is returned and the circuit 
is otherwise in the normal configuration, the IntelliTeam 
system logic will start this timer. After the timer expires, 
the IntelliTeam system logic removes the Transfer Trip  
Prohibit Restoration  (TTPR) mode on the device 
and will then close the device to bring the distributed 
generation device back online. (Range: 0-900 seconds;  
Default = 0 seconds, meaning  the Reconnect DG on Return 
to Normal mode is disabled.)

Note: If for any reason the DG Reconnect Delay Time 
timer is aborted, the timer will not restart automatically 
and the distributed generation device must be manually put 
online.

Note: When an IntelliNode/Info-Only module is not directly 
associated with the distributed generation device, it is up to 
the distributed generation device’s own protection/control 
device (e.g. breaker, inverter, etc.) to reconnect the distrib-
uted generation device, because the IntelliTeam system 
has no control over the device or the reconnection process. 
However, it should be put online when good voltage, current, 
and frequency are seen by the distributed generation protec-
tion/control device. When the IntelliTeam system control is 
an IntelliNode/Info-Only module directly associated with 
the distributed generation device, if it was sent the initial 
Transfer Trip command it will control the reconnection 
process and issue a Close command to the distributed 
generation device’s protection/control device when the DG 
Reconnect Delay Time timer expires.

Note: See S&C Instruction Sheet 1044-578, “IntelliTeam® 
Designer: Distributed Generation Setup and Configura-
tion,” for more information on how to setup and configure a 
circuit with DG devices.

Note: If a Transfer Trip command is programmed to 
be sent to a device on an alternate circuit, set the DG  
Reconnect Delay Timer Time setpoint to a value greater 
than 30 seconds. This should provide the IntelliTeam system 
enough time to close the tie point before the DG Reconnect 
Delay timer expires, which would allow the distributed gen-
eration device to reconnect prematurely.
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Follow these steps to place sources:

STEP  1 .  Place the four sources using the Add Source button on the tool bar, and then 
click on the drawing area to place them.

STEP  2 .  Put SRC 1 on the left and SRC 2, SRC 3, and SRC 4 on the right. Move the sources 
on the right so SRC 2 is on the top and SRC 4 is on the bottom. See  
Figure 34. Text color is automatically adjusted for the source box color.

Note: Use the Repeat Insert button to keep the Add Source tool active until 
all of the sources are placed. Remember to click the Select Item button to 
stop inserting more sources when the Repeat Insert button is selected.

Sources

Figure 35 . Add sources to the drawing space .

STEP  3 .  Move SRC 4 to the lower right-hand corner of the drawing area and SRC 1 to left 
side. Then, select SRC 2, SRC 3, and SRC 4. See Figure 35. Press and hold the 
<Ctrl> key while clicking on each object with the mouse cursor to select 
multiple devices at once. 

Note: There are two ways to select multiple objects, but remember that the 
Select Item button has to be selected first. As shown in  Figure 36 on page 
59, place the mouse cursor to one corner of the area containing the objects, 
press the left mouse button, and drag the mouse cursor across the area. A 
screen will open when the mouse is dragged, indicating which devices are 
included in the selection. All of the objects in the screen will be selected after 
the left mouse button is released.

Note: See S&C Instruction Sheet 1044-579, “IntelliTeam® 
SG Automatic Restoration System: Remote Transfer Trip 
Setup and Configuration,” for more information about 
how to set up and configure devices to send Transfer Trip  
messages to remote devices.
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Figure 36 .  Select SRC 2, SRC 3, and SRC 4 .

STEP  4 .  When all of the objects have been selected, click on the Align Right tool to line 
up the sources with the farthest right source. Then, click the Space Vertically 
tool to evenly space the sources. See Figure 37. 

STEP  5 .  Select SRC 1 and SRC 3. If SRC 1 is above SRC 3, as is the case in Figure 33, click 
on the Align Bottom tool. If SRC 1 is below SRC 3, click on the Align Top tool. 
This action will result in SRC 1 and SRC 3 being in line and vertically centered 
with relation to SRC 2 and SRC 4. See Figure 38.

Figure 38 . Align SRC 1 and SRC 3 .

Figure 37 . Align and space the sources at the right .
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Follow these steps to create wire connection points: 

STEP  1 .  Click on the Add Wire Connections icon in the tool bar and then click on the 
drawing area as indicated in Figure 39. 

STEP  2 .  Place four wire connection points approximately in line with SRC 1 and SRC 3.

STEP  3 .  Place one point above the second wire connection point from the left and the 
remaining three below the other three wire connection points in line with the 
centered sources.

Wire Connection 
Points

Figure 39 . Add wire connection points .

STEP  4 .  Make sure the four wire connection points in the center are all just above or just 
below the center of SRC 1 and SRC 3. Then, select to highlight the four wire 
connection points between SRC 1 and SRC 3. 

STEP  5 .  In the screen shown in Figure 40 on page 61, all connection points are just 
above the center line. Depending on their relationship, use the Align Bottom 
tool or the Align Top tool to center the wire connection points on the two 
selected sources. This action aligns the source termination points with the 
wire connection points. Remember that the Select Item button must be 
clicked first before any alignment or spacing will occur.

60  S&C Instruction Sheet 1044-570

System Design Tutorial



Figure 40 . Align the wire connection points between SRC 1 and SRC 3 .

STEP  6 .  In Figure 39 on page 60, the Align Bottom tool was used. Continue to use the 
spacing and alignment tools until the drawing looks like Figure 41.

Note: When the wire connection points and sources are aligned, adding 
wires is much easier.

Figure 41 . Aligned points make the wire connection process easier .
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STEP  2 .  Click the Repeat Insert tool and the Add Wire tool. Now, when hovering the 
mouse cursor above a wire connection point or a source, the wire termination 
points will change, as shown in Figure 43.

Figure 43 . Wire termination points shown with the Add Wire tool .

Adding Wires Follow these steps to add wires to the wire connection points:

STEP  1 .  Click the side bar pin to open the Component Explorer dialog box if it is not 
already open. Set the zoom to 150%. Use the scroll bars to position SRC 2, as 
shown in Figure 42. 

Note: Zooming to enlarge makes wire placement easier.

Figure 42 . Zoom in to make the wire connection process easier .

Zoom tool

Scroll bars

Side bar pin

Select these tools

Wire connection point
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STEP  3 .  Select the left termination point shown in Figure 37, and drag a wire over to 
SRC 2. Drag the mouse cursor until the termination point on SRC 2 becomes 
visible. Wile holding the mouse cursor over the SRC 2 termination point, release 
the mouse button to make the connection. See Figure 44.

Figure 44 . Release the mouse button over a termination point to make a connection .

Notice after the mouse button is released the wire remains selected as indi-
cated by the wire selection points. This allows grabbing the wire by a selection 
point and completing the connection if the wire has fallen short of the target. 
Click anywhere in the drawing field to deselect the wire before placing the 
next wire. See Figure 45.

Note: Before placing a new wire, make sure existing wires are deselected by 
clicking anywhere in the drawing space.

Note: Verify a wire is connected by grabbing a device and moving it. Just 
click on the undo icon right after the move to move it back to its original 
location.

Figure 45 . White boxes on the wire show it is selected .
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STEP  4 .  Continue placing wires until all of the wires are connected, as shown in  
Figure 46.

Figure 46 . Add wires to complete the circuit .

STEP  5 .  Click on the Substations box followed by clicking on SRC 1 in the Component 
Explore dialog box to position the drawing, as shown in Figure 47.

Figure 47 . Automatic zoom to the selected substation .
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STEP  7 .  Continue placing wires until the connections shown in Figure 49 are complete.

Figure 49 . Add more wire connections .

STEP  6 .  Click on the side bar pin to increase the drawing space and use the scroll bars 
to position the drawing, as indicated in Figure 48.

Figure 48 . Click the side bar pin to increase drawing space .
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STEP  8 .  Using the scroll bars, reposition the circuit (as shown in Figure 49 on page 
65) and use the Add Wire Connection tool to add two wire connection points 
as indicated. Using the alignment and spacing tools, arrange the Wire 
Connection points to look something like Figure 50.

Note: Turning the grid off can make it easier to straighten wires.

Figure 50 . Adding two wire connection points and aligning them .

STEP  9 .  Continue adding wires until the connections shown in Figure 51 are complete.

Figure 51 . Connect the new wire connection points .
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Follow these steps to add switches to the circuit design:

STEP  1 .  Select the Repeat Insert and Add Switch tools to insert all of the switching 
devices shown in Figure 53.

Note: If switches are misaligned, use the alignment tools to straighten the 
group of switches. Use the spacing tools to create equal spacing between 
switches. Also, if adding a switch that does not automatically merge to the 
wire, just click the Undo button to remove the switch.

Adding Switches

Figure 53 . Insert switching devices with Repeat Insert and Add Switch tools .

STEP  10 .  Set the zoom to 100% and use the scroll bars to position the circuit, as shown in 
Figure 52.

Figure 52 . View the circuit at 100% zoom .

Select these tools
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STEP  2 .  To draw a Pad-Mounted Switchgear or Vista® Underground Distribution 
Switchgear configuration, add the switch to the wire with the Add 2 Switch 
button to create the “Switch 1 Switch 2” entry.

STEP  3 .  If there is a third manual switch, add it as a switch on the line and then use the 
Exclude/Include button to convert it to a non-team closed manual switch, or 
use the Exclude/Include Open button to convert it to a non-team open manual 
switch. See Figures 54 and 55.

Note: To swap the switch positions on a two-switch device, right click on 
the pad-mount drawing and select the Swap Switch Positions command, 
as shown in Figure 56 on page 69.

Figure 54 . Three-switch pad-mount configuration, with a normally closed non-team  
manual switch .

Figure 55 . Three-switch pad-mount configuration, with a normally open non-team  
manual switch .
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Use the Repeat Insert and Toggle Switch Open/Close tools to set the normally open 
points, as shown in Figure 56.

Note: Use the Toggle Terminal tool at the right of the Toggle Switch Open/Close tool to 
change the location of the open points. Notice that this was done for all of the vertical 
switches in Figure 57.

Setting the Normal 
State

Figure 56 . Swapping switch positions on a two-switch device .

Figure 57 . Set the normally open points with Repeat Insert and Toggle Switch Open/
Close tools .

Select these tools

S&C Instruction Sheet 1044-570  69

System Design Tutorial



Figure 58 . The Validate tool automatically assigns team ID designation to each team .

Follow these steps to validate the circuit layout:

STEP  1 .  After completing the circuit layout, click on the Validate tool, which will 
automatically assign team ID designations to each team and check the circuit 
for errors.

STEP  2 .  After validation, the line sections will be the same color as the source powering 
them. Click on the Configuration Display pin to open the Configuration 
screen, which contains the Validation tab. See Figures 58 and 59. 

STEP  3 .  Save this screen work.

Validating

Figure 59 . Validation makes line segments the same color as their source .

File name shown 
in tab after file 
has been saved

Validation tab

Configuration 
Display pin

Validation tool
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Figure 60 .  A fragmented circuit fails validation because not all sources are connected to 
the circuit .

If circuit validation shows a fragmented error, use the Trace Connections command to 
display source colors and identify where the disconnect is located. See Figure 57. If the 
wires connected to a source remain black, this indicates these wires are not connected 
to the other circuit.

When all sources are connected to the circuit, the Trace Connections command 
will display all wires the same color as their source. See Figure 61.

Trace Connections

Figure 61 . The Validate tool will color wires the same color as their source .

Note: If all sources are not connected to the circuit, validation will show the error:  
Fragmented Circuit. Fragmentation errors are defined in the Errors and Warnings  
dialog box. See Figure 60 for a fragmented circuit example.

Fragmented Circuit
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Follow these steps to enter the RTU addresses and serial numbers:

STEP  1 .  If all goes well, the only validation warnings at this time are the missing RTU 
addresses and serial number assignments. Click on the Device Attributes tab 
and select a device.

STEP  2 .  Enter an RTU address in the configuration editor at the right.

STEP  3 .  Select the serial number for the device.

STEP  4 .  When all of the missing RTU addresses and serial numbers have been entered, 
click on the Validation button again; this will delete the associated warnings. 
See Figure 62.

RTU Address and 
Serial Numbers

Figure 62 . Enter RTU addresses in the configuration editor .

Follow these steps to enter or revise device attributes:

STEP  1 .  On the Netlist Configuration dialog box, select the Device Attributes tab. See 
Figure 62.

STEP  2 .  In the Device Attribute Editor, select the item to edit in the Netlist configuration. 
Select RTU Address, IP Address, Serial Number, or CEC Allowed. For this 
example, we will edit the IP address.

STEP  3 .  Manually enter each entry for the IP address.

Updating Attributes

Multi Update Attributes

Device Attributes tab

Edit IP Address

Select Serial Number
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Figure 63 . Multi-Update buttons on the Device Attribute dialog box .

Figure 64 . Shift click to highlight a range of devices .

STEP  4 .  The multiple attributes that contain the Multi-Update button also can be 
automatically updated. A Multi-Update button with a “+” indicates the multi-
update function will increment the values. For example, a multi-update applied 
to the RTU attribute will set the devices’ RTU values to 1, 2, 3, … while a multi-
update to the CEC Allowed attribute will set all selected devices to CEC 
Allowed mode. See the following steps about invoking multi-updates. See 
Figure 63.

STEP  5 .  Highlight the range of devices to automatically enter a value for. Click on the 
first device, and shift-click the last device to establish a range. See  
Figure 64. To enter a group of individual devices, control-click the devices or 
use control-A to select all lines. See Figure 65 on page 74.
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Figure 66 . Enter the IP address in the Device Attribute dialog box .

Figure 67 . The IP Address Multi Update button .

STEP  6 .  Enter the IP address to be configured sequentially. See Figure 66. 

Figure 65 . Control click to highlight a group of individual devices .

STEP  7 .  Toggle the Multi Update button next to the IP attribute. See Figure 67.
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Figure 68 . New values entered in the Summary of Changes dialog box .

Figure 69 . IP addresses have been updated .

STEP  8 .  Click on the button with the check at the top right to apply the change. The 
Summary of Changes dialog box will open. See Figure 68. Click on the Yes 
button to apply the changes.

STEP  9 .  This will update the devices with incrementing IP addresses (i.e. 192.168.200.1, 
192.168.200.2, etc.). See Figure 69.
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Figure 71 . The Multi Update dialog box .

Figure 70 . The Multi Update buttons on the Device Attribute dialog box .

STEP  10 .  Alternatively, use the Multi Update dialog box to make multiple updates.  Select 
the desired attributes to edit, and click on the Multi Update Dialog Box 
button. Only attributes with Multi Updateable values are visible. See Figures 70 
and 71.
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Figure 72 . CEC Allowed value is selected .

Figure 73 . Netlist Configuration shows the completed changes .

STEP  11 .  Toggle the Serial Number button and select a starting serial number.  Also 
toggle the CEC Allowed button and check the box for CEC Allowed. See  
Figure 72.

STEP  12 .  Click on the Apply button to immediately apply the Multi Update values and 
keep the Multi Update dialog box open, or click on the OK button to apply and 
close the Multi Update dialog box. The changes will now be entered in Netlist 
Configuration. See Figure 73.
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Figure 74 . Team designations are shown on the circuit .

In the example in Figure 74, an IntelliNode Interface Module is at each source, and DS 15 
must be added to SRC 4.

Notice there are teams designated by “T#,” and sub-teams “ST#” that indicate a  
section of line between a source and the first IntelliTeam SG system device.

Team Designations
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Figure 76 . The Device Attribute dialog box edits the IP address .

Figure 75 . The Component Explorer and Visual Properties dialog boxes .

Follow these steps to revise device attributes and revalidate to update the team 
designations: 

STEP  1 .  Using the Component Explorer dialog box, one by one select DS 2, DS 4, DS 7, 
and DS 15. As each switch is selected, use the Visual Properties dialog box to 
change the Device Type setting from “IntelliRupter” to “IntelliNode.” See 
Figure 75.

Device Attributes

STEP  2 .  Use the Device Attributes tab found in the Netlist Configuration dialog box 
to configure the IP address. See Figure 76.

S&C Instruction Sheet 1044-570  79

System Design Tutorial



Figure 77 . The Team Attributes tab is used for editing team parameters .

STEP  4 .  Click on the Team Member Attributes tab below the configuration dialog 
box and the Team Member Attribute dialog box will open to the right. Highlight 
the Team ID entry for the team to configure. See Figure 78.

(a) Configure the Maximum Capacity setpoint.

(b) Configure the Return to Normal Mode setpoint.

For more information on team member attributes, please see the “Team 
Member Attributes Tab” section on page 49.

Figure 78 . The Team Member Attributes tab is used for editing team member settings .

STEP  3 .  Click on the Team Attributes tab to open the Team Attribute dialog box to the 
right. See Figure 77.

(a) Configure the Line Segment Limit setpoint.

(b) Configure the Contracts Required setpoint to the On or Off mode.

(c) Configure the Return to Normal Time setpoint.

(d) Configure the Prohibit Restoration Time setpoint.

For more information on team attributes, please see the “Team Attributes 
Tab” section on page 43. For more information on the operation of the 
IntelliTeam SG system, review S&C Data Bulletin 1044-92, “IntelliTeam® SG 
Automatic Restoration System: Dispatchers Guide.”
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STEP  5 .  Click on the Substation Attributes tab below the configuration dialog box 
and the Substation Attribute dialog box will open. Highlight the Substation ID 
entry for the source to configure. See Figure 79.

(a) Check the Set Max Capacity as Disable checkbox to disable the use of this 
source, if desired. To keep the source enabled, do not check this checkbox.

(b) Configure the Maximum Capacity setpoint.

(c) Configure the Overload Permitted setpoint for the amount this source 
can be overloaded, if desired. A value of “0” will not allow an overload to 
occur.

(d) Configure the Time Overload Permitted setpoint for the allowed duration 
of the overload condition, if desired. A value of “0” will not allow an overload 
to occur.

(e) Configure the Overload Qualification Time setpoint for the time required 
to qualify the overload condition. This setpoint is only used if the Overload 
Permitted setpoint is in the Enabled state.

(f) Configure the Enable/Disable Restore to Max Capacity Plus Overload 
setpoint, which allows an overload condition during a restoration event.

These attributes need to be configured per the operating needs of the  
IntelliTeam system and should be reviewed by a qualified S&C application 
engineer or field service representative before being applied to a system. For 
more information on substation attributes, see the “Substation Team Attributes 
Tab” section on page 54.

Figure 79 . The Substation Attributes tab is used for editing source parameters .

STEP  6 .  Click on the Distributed Generation Attributes tab below the configuration 
dialog box and the Distributed Generation Attribute dialog box will open. 
Highlight the Distributed Generation ID entry for the DG device to configure. 
See Figure 80 on page 82.

(a) Configure the Default Load Contribution setpoint if needed. Otherwise, 
leave it at the default of “0,” meaning it is disabled and not used.

(b) Configure the DG Reconnect Delay Timer setpoint if IntelliTeam should 
attempt to reconnect the DG device after the IntelliTeam system has 
completed the Return to Normal process. 

For more information on the Distributed Generation attributes, see the 
“Distributed Generation Attributes Tab” section on page 56.
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Figure 81 . When a validation is successful, the circuit is ready to deploy .

STEP  7 .  Run the Validate command to display any new errors. Correct the errors and 
save the work. The IntelliTeam SG system is now configured and ready to 
deploy the IntelliTeam SG system device attributes. See Figure 81.

Customize the circuit with image files, user-defined text, and by drawing 
objects. Show or hide wire connections by clicking on the Show Wire  
Connections option in the Option menu. None of these changes require  
validation to be re-run because they are visual changes only and do not affect the  
IntelliTeam system circuit or settings.

Note: For version 7.6 and later, when validation is run a warning message 
will appear if a source/sub or tie/sub device has been configured with the 
sensor facing the load and not the source. S&C recommends the sensor faces 
the source for proper operation of the IntelliTeam system.

Note: For version 7.6 and later, IntelliRupter fault interrupters are now 
allowed on a closed loop main line along with 6801 Series controls with 
Scada-Mate switches. See Instruction Bulletin 1044-580, “IntelliTeam® 
Designer: Closed Loop Operation.”

For more information on the operation of the IntelliTeam SG system, review 
S&C Data Bulletin 1044-92, “IntelliTeam® SG Automatic Restoration System: 
Dispatchers Guide.”

Figure 80 . The Distributed Generation Attributes tab is used for configuring DG device 
parameters .
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The Netlist is a system configuration database for an IntelliTeam SG Automatic 
Restoration System. It includes information about team member connectivity, load con-
straints, device function, and enabled features.

Because the IntelliTeam SG system is highly scalable and can operate extremely large 
systems, the Netlist is divided into subsets called FeederNets. A FeederNet has data 
for the group of all switches fed by a single source. Because power could flow in either 
direction through a normally open switch when it’s closed, FeederNets overlap at open 
points, and each open point will be listed in the two adjacent FeederNets.

Because the system is divided into FeederNets, only the affected FeederNets must 
be updated when making a change. If a normally closed switch is inserted in a series 
of normally closed switches, only one FeederNet and its associated field devices will 
require updating. Similarly, if an open point between two FeederNets is moved, only 
those FeederNets and the associated field devices require the update.

Typically, each FeederNet has one entry point device, and that is the switch closest 
to the substation. The only exception is the rare case where there are multiple open sub-
station switches in a FeederNet and no closed switches; in that case, every one of those 
open substation switches is an entry point device.

With a closed-loop system, only one of the two sources is listed in the FeederNet when 
it is configured. For firmware versions 7.1 and earlier, when the IntelliTeam SG system 
begins to operate in a closed loop, it dynamically updates switch functions based on 
load flow and determines the approximate center point, which is the logical place to 
sectionalize during an event. For more information on closed loops with the IntelliTeam 
SG system using firmware versions 7.1 and earlier, refer to S&C Instruction Sheet  
1044-574, “IntelliTeam® Designer: Closed-Loop Operation.”

When running firmware version 7.3 and later, the IntelliTeam SG system will use the 
configured center point switch to break the closed loop when a sectionalizing event 
occurs. For more information on closed loops with the IntelliTeam SG system running 
firmware version 7.3 and later, refer to S&C Instruction Sheet 1044-580, “IntelliTeam® 

Designer: Closed Loop Operation.”

Overview

Versions 2.0.0.0 and later of IntelliTeam Designer have license-management  
activation. See the “License Management” section on page 9 for more information. To 
use the latest IntelliTeam SG system features, update the software in the field devices, 
install the new version of IntelliTeam Designer, and re-push a new Netlist in all the devices 
on the circuit. Follow these steps to update the software:

STEP  1 .  Update the software in the field devices. Follow the instructions in the various 
product installation guides for details on how to perform the software  
upgrades.

STEP  2 .  Update the IntelliTeam Designer application to the latest release.

STEP  3 .  Open the existing Netlist configuration one-line diagram in IntelliTeam 
Designer and configure any of the new features that are desired.

STEP  4 .  Click on the Validate button. Validation creates new FeederNets and enables 
the new IntelliTeam features in the new software. Now save the new circuit 
configuration. When this is done, follow the procedure shown in the  
“Configuring Field Devices” section on page 84 to update the field devices.

Updating IntelliTeam 
SG Software
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To push the IntelliTeam SG system settings to S&C controls, the settings must be propa-
gated to an entry point device within the FeederNet. And to push the IntelliTeam II system 
settings to S&C controls, the settings must be sent to each device individually. This is 
accomplished using the communication manager. See Figure 83 on page 85. 

The communication manager is divided into four tab sections titled Entry Point 
Device Configuration, Device Configuration Status, Operational Log, and 
FeederNet Status. There is also a toolbar that contains various tools to facilitate and 
monitor the process of pushing the settings to the controls. These are explained in detail 
in the “Communications Tools” section on page 85.

Communications 
Manager

Figure 82 . The Communicate to Devices icon .

Follow these steps to configure the field devices:

STEP  1 .  Set IntelliTeam Designer to the Draw mode (the default when IntelliTeam 
Designer opens).

STEP  2 .  Open the validated circuit, File>Open or File>Recent Files, if not already open.

STEP  3 .  Click on the Communicate to Devices icon, which opens the Communication 
Manager screen. See Figure 82 on page 84 and Figure 83 on page 85.

STEP  4 .  Follow the procedure described in the following sections to continue with field 
device configuration.

Configuring Field 
Devices
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Figure 83 . The Communications Manager>Entry Point Device Configuration screen .

Check

Push

Clear

Monitor/Stop

Show/Hide Comm

FMS Export

Copy

Check
The Check button verifies the FeederNet entry point devices have the same Node ID and 
CRC, and it checks communications between the IntelliTeam Designer software and the 
entry point devices. This creates a summary report of communication check success or 
failure for all devices.

For versions 7.5 and later, this button also checks the firmware each device is running 
and sets the appropriate Netlist propagation version to use. 

Note: When performing a communications check, enabled devices on the FeederNets 
will be checked. To disable a FeederNet during a communications check, uncheck the 
Enable check box and uncheck the Retrieve Data from All Devices check box.

Communications 
Tools
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Note: With version 7.6 and later, the check function has changed. When the check com-
munications function completes and there are devices that did not respond during the 
initial check, clicking on the check button again will only check those devices that did 
not respond instead of checking all devices on a FeederNet again.

However, if any communication settings are changed after the initial check is per-
formed, then re-running the check function will test all devices again on the FeederNet.

Note: If devices are running different firmware versions, the propagation version can-
not be set and the Push function will remain disabled until they are all running the 
same firmware version and the appropriate propagation version can be set.

Note: The Prohibit Restoration mode must be cleared from a device being removed 
from an IntelliTeam SG system before pushing a new Netlist to avoid issues.

Push
The Push button starts pushing the Netlist information to all enabled FeederNets. Check 
the Status column in the Device Configuration dialog box (for IntelliTeam SG systems) 
or setpoints (for IntelliTeam II systems), and the state will change from Unknown to 
Delivered to Accept if everything goes well.

Clear
The Clear button clears all Netlists and disables runners. This button must only be used 
when configuring IntelliTeam II system circuits and not using the setpoint file option. 
It is not required to clear Netlists before a Push command because that is now part of 
the push process itself. Refer to S&C Instruction Sheet 1044-577, “IntelliTeam Designer: 
IntelliTeam® II Setup and Configuration,” for more information on IntelliTeam II 
mode of operation.

NOTICE
The Clear button disables all IntelliTeam SG system features and puts the teams in 
IntelliTeam II mode only .

Monitor/Stop
The Monitor/Stop button checks status of the FeederNets and devices in the Device 
Configuration tab. Use this function to monitor the status of the Netlist push and deter-
mine whether the actual FeederNets that the device has are the expected FeederNets.

Note: The log entries in the Operation Log will update with this status information  
when the Monitor function is enabled. However, it may take several minutes after the 
log entry that states “Push is complete” to actually update the secondary FeederNets 
in devices.

Show/Hide Communication Settings
The Show/Hide Communications Settings button opens more data in the Entry Point 
Device Configuration and Device Configuration tabs.

FMS Export
The FMS Export button exports IntelliTeam Designer data to the IntelliTeam FMS 
Feeder Management System software.
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The dialog box tab for the communication manager (see Figure 84) has the following 
options available:

• Float—Allows the dialog box to float within the IntelliTeam Designer application

• Dock—Docks the dialog box in the Tree View area

• Dock as Tabbed Document—Docks the dialog box in the drawing area

• Auto Hide—Hides the dialog box

• Close—Closes the dialog box and closes the communication manager

Dialog Box Tab

Figure 84 . The Communication Manager Dialog box tab .

Copy
The Copy button copies the Operational Log information to a clipboard for use in other 
applications.

Auto Scroll
The Auto Scroll button will continue or stop Operational Log scrolling. Auto scrolling 
can also be activated by selecting/scrolling to the last item in the log, and it can be deac-
tivated by selecting/scrolling to a line item other than the last item in the log. However, 
auto scrolling will not become enabled by checking this box manually. Auto scrolling will 
become enabled automatically when a Push or Check operation is executed.

Propagation Status
The Propagation Status field shows the progress of the Netlist propagation to all the 
enabled FeederNets.

Last Update Status
The Last Update Status field shows a time-stamped update of the last action being 
performed.

Summary Report
The Summary Report field presents information about each FeederNet propagation, 
whether it was successful, pushed, retried, or failed. There is also a summary report for 
checking communications status.

Quick Help
The Quick Help dialog box displays FeederNet Configuration help text.
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This tab is used for communication setup to entry point devices for the Netlist Push 
process. See Figure 83 on page 85.

Entry Point Device
Select the entry point device to be used by the FeederNet. The default is the first device 
on the feeder that is either the source/sub or tie/sub device.

Note: The entry point device reverts to the default selection when the communication 
manager is closed.

Connection Type
Select the connection type used to connect to the entry point device. Options are: None, 
Serial, IP, LinkStart (WiFi), ICPSerial, ICPIP, and WAN.

NOTICE
The LinkStart connection type connects to only one device at a time . To propagate 
the FeederNet data, push a FeederNet to each device on the circuit one at a time . 
A LinkStart connection type should not be used for circuits with more than two 
devices .

DNP Address
This is the DNP address of the entry point device. This value is programmed into the 
configuration based on the information configured in the Device Attributes tab. The 
Use Self option, when checked, uses the devices DNP self address instead of the pro-
grammed DNP address.

Serial Port
Select the serial port used to connect to a control when the connection type is specified 
for serial connections. Options are COM1 through COM250.

Retry Time (Seconds)
This is the number of seconds each retry will be performed when a Netlist push to an 
entry point device is not successful.

Retry Count
This is the number of retries that will be performed when a Netlist push to an entry point 
device is not successful.

Baud Rate
This is the baud rate used for serial connections. Options are: BR1200, BR2400, BR4800, 
BR9600, BR19200, BR38400, and BR57600.

Our RTU
This is the RTU address of the device being used to connect to the entry point device. 
Use the default of 65431 unless otherwise instructed.

Entry Point Device 
Configuration Tab
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User Name
This is the username used to connect to the entry point device.

Password
This is the password used to connect to the entry point device.

Parameters Common to All Entry Points
The Parameters Common to All Entry Points button sets the communication param-
eters common to all entry point devices on the FeederNets. See Figure 85 on page 90. 

Note: Passwords are not displayed on the main configuration area but are still saved 
for that session. When the communication manager is closed, the password must be 
re-entered.

Disable/Enable All FeederNets
The Disable/Enable All FeederNets button enables or disables the Netlist push to all 
FeederNets.

Note: Individual FeederNets can be enabled or disabled by clicking on the Enable 
check box next to each FeederNet.

Retrieve Data from All Devices
When checked, the Retrieve Data from All Devices option will check communications 
for all disabled and enabled FeederNets when the Check communications function is 
executed.

Note: When this option is checked, all devices will be checked during a communica-
tions check even if they are on a FeederNet that is disabled (unchecked) in the com-
munications manager.

Import Comm Setup File
The Import Comm Setup File button allows a user to select a communications setup 
file from their PC to pre-load the communications parameters into the Entry Point 
Device Configuration tab.

Export Comm Setup File
The Export Comm Setup File button allows a user to save the existing communica-
tions parameters they have programmed to a communication setup file that can be later 
imported using the Import Comm Setup File option.

Options
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Filter
The Filter tab filters the information shown in the Device Configuration tab. Options 
are: 

Show All—Displays all information during the Netlist push process 

Show Errors—Displays only errors seen during the Netlist push process 

Show Completed—Displays the FeederNets that have had a successful push 

Show In Progress—Displays the FeederNets that are still in progress of getting their 
Netlist data

Options
The “Options” section configures communication parameters:

Figure 85 . The Device Configuration Tab screen .

The Device Configuration Tab screen displays the progress of the current Netlist propa-
gation to the FeederNet devices. Normally open devices are shown twice in the device 
list because they are associated with two FeederNets. See Figure 85.

Note: For version 7.6 and later, the Device Configuration tab will only show those 
FeederNets that are enabled in the Entry Point Device Configuration tab. Previous 
versions will show all FeederNets no matter if they are enabled or disabled.

Device Configuration 
Tab
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Parameters Common to All Entry Points
The Parameters Common to All Entry Points button sets all the communication 
parameters common to all entry point devices on the FeederNets. 

Note: Passwords are not displayed on the main configuration area but are still saved 
for that session. When the communication manager is closed, the password must be 
re-entered.

Max Secondary Acceptance Iterations
The Max Secondary Acceptance Iterations control sets the number of attempts the 
entry point device will propagate the secondary FeederNet information to devices when 
the initial propagation is not successful. (Range: 20-100)

Transactions
The “Transactions” section selects Netlist Push operation options.

Push Netlists into Enabled FeederNets
The Push Netlists into Enabled FeederNets button starts the Netlist propagation 
(push) process to the entry point devices when all communication parameters have been 
configured. Clicking on the Halt button after a Push operation has started will stop the 
process. To resume the Push operation, click on the Push button.

Monitor FeederNet Configuration Status
The Monitor FeederNet Configuration Status button starts the monitoring process, 
which shows updates on the Device Configuration screen as the Netlists are propagated 
to the individual FeederNets.
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Verbose Logging
When checked, the Verbose Logging tab turns on verbose logging in the Operations 
Log. This feature should only be used when troubleshooting because it adds additional 
overhead and processing to the push process and could cause it to slow down.

Note: For version 7.6 and later, the Verbose Logging feature is disabled by default. 
For previous versions, users must disable this feature if they do not want the additional 
logging data.

Auto Scroll
When checked, the Auto Scroll tab will continue or stop Operational Log scrolling. 
Auto scrolling can also be activated by selecting/scrolling to the last item in the log, and 
it can be deactivated by selecting/scrolling to a line item other than the last item in the 
log. However, auto scrolling will not become enabled by checking this box manually.

Copy Contents to Clipboard
The Copy Contents to Clipboard button copies the Operational Log information to 
the clipboard for use in other applications.

Figure 86 . The Operational Log Tab screen .

The Operational Log Tab screen displays communication system operation and logs all 
the relevant information during the push process. See Figure 86.

Operational Log Tab
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The FeederNet Status Tab screen displays more detailed information about the progress 
of the present Netlist propagation. See Figure 85 on page 90.

Filter
The Filter button filters the information shown in the FeederNet Status tab. Options are: 

Show All—Displays all information during the Netlist Push process

Show Errors—Displays only errors that are seen during the Netlist Push process

Show Completed—Displays the FeederNets that have had a successful push

Show In Progress—Displays the FeederNets that are still in progress of getting their 
Netlist data.

Polling Interval
The Polling Interval setpoint adjusts the monitoring and polling frequency of the 
FeederNet Status log. (Range: 5.00 to 15.00 milliseconds)

Note: Using a fast polling rate could tax the processor on the computer that is being 
used to perform the push.

HTML
The HTML button dumps the FeederNet Status log to an HTML file.

Clear
The Clear button clears the information shown in the FeederNet Status log.

FeederNet Status Tab

This section describes the process for propagating the IntelliTeam SG system settings to 
the S&C controls. It is shown as the general workflow used to perform propagation and 
general troubleshooting steps that may be required to analyze propagation problems. 
For configuring devices using the communication manager for IntelliTeam II mode, 
see S&C Instruction Sheet 1044-577, “IntelliTeam® Designer: IntelliTeam® II Automatic 
Restoration System Setup and Configuration.”

Setting up Communications
Follow these steps to configure communication parameters:

STEP  1 .  In the Entry Point Device Configuration tab, select a FeederNet from the list 
by clicking it. In the majority of cases, the entry point device for the FeederNet 
is automatically selected in the Entry Point Device pull-down box. For the rare 
case when there are multiple entry point devices (all switches in the FeederNet 
are open substation switches), different entry point devices may be selected.

STEP  2 .  Make a selection from the Connection Type pull-down menu and fill in the 
details required for that connection type. 

Propagation

Clear Log
The Clear Log button clears the information shown in the present Operations log.

S&C Instruction Sheet 1044-570  93

System Configuration



NOTICE
The LinkStart connection type connects to only one device at a time . To propagate 
the FeederNet data, push a FeederNet to each device on the circuit one at a time . A 
LinkStart connection type should not be used for circuits with more than two devices . 
If a FeederNet contains more than one device, propagating and monitoring the 
FeederNet information successfully requires the PC running IntelliTeam Designer 
to have an Ethernet connection to the entry point device that allows communication 
to all other devices on the FeederNet .

STEP  3 .  If the device type is IntelliRupter® PulseCloser® Fault Interrupter, a 6800 
Series Automatic Switch Control with security, or an IntelliNode Interface 
Module (v6.3 or later), a username and password must be entered. 

Note: When entered, a username will be remembered. However, the pass-
word is not saved and must be re-entered each time the communication 
manager is opened. Also, DNP addresses and IP addresses are loaded from 
the Netlist and cannot be modified by the communication manager. Make 
sure all address information is up-to-date before opening the configuration 
manager.

Note: Parameters shared by all devices can be entered on the Common Com-
munication Parameters dialog box to expedite communications setting setup 
for all entry point devices. See Figure 83 on page 85. Open this by clicking 
the Parameters Common to All Devices Set button. Passwords will not be 
displayed on the main configuration area but are still saved for that session. 
If the communication manager is closed, the password must be re-entered. 
See Figure 87.

Figure 87 . The Common Communication Parameters dialog box .
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Figure 88 . The Operational Log screen showing a successful communications check .

When the communication settings are configured for all entry point devices, the next 
step in the propagation process is to check the communications between the IntelliTeam 
Designer software and the entry point devices and to gather any existing Netlist data from 
the devices. Follow these steps to check communication with the entry point devices:

STEP  1 .   Click the Check button to test communication and collect information about 
Netlists presently loaded into the devices. When completed, a dialog box will 
show success or failure of the communication check.

STEP  2 .  Click the Operational Log tab to see a report of the communication test. A 
summary report is shown at the bottom. The log contents can be copied to the 
clipboard for future reference. See Figure 88.

Testing 
Communications and 
Retrieving Device 
FeederNet Data

STEP  3 .  If there were any devices that did not pass the communication check, re-run 
the Check function by clicking on the Check button again.

Note: For versions earlier than 7.6, re-running a Check function will re-
check all devices again. For versions 7.6 and later, re-running the Check 
function again will only test those that did not pass the initial check, as long 
as no communication settings are changed.

STEP  4 .  When all devices have passed the communication check, proceed to the 
propagate Netlist process steps.
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Starting the Netlist Propagation
To make sure an out-of-date Netlist is not propagated when a field device is configured 
locally, a Propagate Netlist Enable/Disable setting is provided in the IntelliLink Setup 
Software for software versions earlier than 7.1.x. The 7.1.x version of software always 
has this setting enabled. Therefore, it is no longer required when using that version of 
software or later. See Figure 89.

Figure 89 . The Propagate Netlist option in the IntelliLink Setup Software tool .

Follow these steps to propagate the Netlists:

STEP  1 .  For software versions before 7.1.x, confirm all field devices have the  
Propagate Netlist function in the Enabled mode before propagating a new 
FeederNet. 

STEP  2 .  Select the FeederNets to be updated by checking one of the Enabled check 
boxes or clicking on the Enable button next to the Disable/Enable All 
FeederNets option in the Entry Point Device Configuration tab. See  
Figure 90 on page 97.
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Figure 90 . The options to enable FeederNets for propagation .

STEP  3 .  For version 7.5 and later, click on the Check button to run a communications 
check, which will verify the version of firmware the devices are running, so the 
appropriate Netlist version is configured on the devices. All devices must pass 
the communications check to proceed. For more information on the Com-
munications Check process, see the “Testing Communications and Retrieving 
Device FeederNet Data” section on page 95.

Note: All devices must be running the same firmware version before a push 
will be allowed.

Note: The Push button will change to a Halt button when clicked. Clicking 
on the Halt button will abort FeederNet transmission, and this is not recom-
mended unless there are errors occurring during the push process.

STEP  4 .  Verify the actual switch states in the field match the expected switch states in 
IntelliTeam Designer before proceeding. Inconsistencies could lead to 
unexpected behavior. A dialog box will open: “Do you wish to push the enabled 
FeederNets? Selecting “Yes” will proceed with the push; selecting “No” will 
cancel the push. See Figure 91 on page 98.
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Figure 91 . The Push FeederNets dialog box .

It usually takes a couple of minutes to transmit one FeederNet. So, if there are several 
enabled FeederNets, the transmission may take some time to complete. Also, when the 
FeederNet propagation has completed (whether successful or unsuccessful) a message 
box under each progress bar will summarize the status, and the Operational Log will 
contain detailed information about the transmission. 

Note: The communication manager automatically hides the other tabs and switches 
to the FeederNet Status tab when propagation starts. However, during propagation, 
all the other tabs may be used. The actual FeederNet information will also continue to 
update on the other tabs as the IntelliTeam Designer software retrieves feedback from 
the devices. 

Note: When a Push operation is started, a second push must not be attempted until the  
configuration timer expires. This timer is configured by the Comm Check Runner 
Timeout setpoint located on the Setup>Restoration>IntelliTeam SG>Communications 
screen. The default value for this setting is 120. See Figure 93 on page 99.

The FeederNet Status tab will now display the status of the push in real-time, and 
the Percent Complete indicator will indicate progress of the entire update. In addition, 
the progress bars and LEDs on the left will indicate progress of each FeederNet push. 
Once a successful push has been completed, all the LEDs will be green, and the status 
will show “Completed.” See Figure 92.

Figure 92 . The FeederNet Status tab indicating a successful Netlist push .
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Enabling Only Changed FeederNets
If updating a system to change IntelliTeam system settings, add, remove, rewire devices 
or substations, or change the normally open point, push the new Netlist to the changed 
FeederNets. If unsure whether a FeederNet requires updating, after the communica-
tion check has been completed, determine it from the table in the Entry Point Device 
Configuration tab. FeederNets out of date with data in their entry-point device will be 
shown in red, while FederNets that match data in their entry point device will be shown 
in green. Generally, push the FeederNets shown in red. 

Further analyze the FeederNet data in the devices by studying the FeederNets in the 
Device column in the Entry Point Device Configuration tab. It will list all FeederNets 
(using ID/CRC pairs as FeederNet identifiers) present in the entry point device. A cyclic 
redundancy check (CRC) is run on each FeederNet after validation to create the unique 
CRC number for each FeederNet. For the device to be fully up to date, that list should 
include the FeederNet(s) the device is a part of and all the adjacent FeederNets. See 
Figure 94 on page 100 and Figure 95 on page 100 for examples. 

Follow these steps to perform a Push operation to only the changed FeederNets:

STEP  1 .  Click on the Check button to check the FeederNets loaded in the entry point 
devices. See Figure 90 on page 97 as an example of this output.

STEP  2 .  Click on the Disable button next to “Disable/Enable All FeederNets” in the 
Entry Point Device Configuration tab, and then check the box under the 
Enabled column in the FeederNet table for the FeederNets that require a new 
push to be performed.

Figure 93 . Entry point devices with out-of-date FeederNets shown in red .
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Figure 94 . Entry point devices with out-of-date FeederNets shown in red .

Figure 95 . Entry point devices with up-to-date FeederNets shown in green .

STEP  3 .  Check the Device Configuration tab to see the list of the FeederNets enabled 
for the Push operation. See Figure 96 as an example.

Figure 96 . The FeederNets that will be pushed .

STEP  4 .  Click on the Push button to begin the propagation process and push the Netlist 
data into enabled FeederNets.

Note: The Push button will change to a Halt button when clicked on. Click-
ing on the Halt button will abort FeederNet transmission, and this is not 
recommended unless there are errors occurring during the Push process.

The FeederNet Status tab will now display the status of the push in 
real time, and the Percent Complete indicator will indicate progress of the 
entire update. In addition, the progress bars and LEDs on the left will indicate 
progress of each FeederNet push. When a successful push has been completed, 
all the LEDs will be green and the status will show as being completed. See 
Figure 97 on page 101.
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Figure 97 . The FeederNet Device Status Accept indication .

IntelliTeam Designer also checks the switch state of each member before the IntelliTeam 
system goes into the Ready state. If a device is not in the proper state, the Ready state 
will not be achieved for that device and the teams for which it is a member. The selected  
IntelliTeam Designer features can also affect the time it takes to enter the Ready state. 
Also, a Prohibit Restoration command or a manual switch operation will prevent the 
system from going into the Ready state after all the FeederNets have been accepted, so 
these will need to be cleared to get the teams into the Ready state.

Monitoring and Validating a Netlist Push
The table in the Device Configuration tab is maintained in real time during the propa-
gation. It contains one entry per device per FeederNet, so the tie switches will be listed 
twice because they are each associated with two FeederNets. The table contents will 
only list devices in the presently enabled FeederNets.

While the Netlist propagates, the Status column in the table will update for each 
device as FeederNet information is received. When confirmation of an Active status 
is received, the value of the Status field in the Device Configuration tab will change 
from the black, “Unknown,” to green, “Accept,” as shown in Figure 96.

When there are no connectivity changes involved, the blue Delivered state may be 
entered temporarily. The Status field can also be updated at any time by running the  
Monitor FeederNet Configuration Status process. To begin the process, click on the  
Monitor button, which changes to a Stop button while the process is running.

The Status field will also indicate whether there are issues detected. When a new 
FeederNet has not been accepted within the allowed time (a communication problem), the 
status indication will change to red and the Status field will display a Timeout condition. 
If there are issues where the actual FeederNet information does not match the expected 
FeederNet information for the secondary FeederNets, the row will be highlighted yellow.

Note: Before IntelliTeam Designer can enter the Ready state, an Accept status is 
required for all FeederNets. Achieving the Ready state may take several minutes after 
all the FeederNets have been accepted. See Figure 96.
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Instant Replay enables the collection and replay of IntelliTeam SG system data generated 
by an event. The data collected by Instant Replay are a filtered subset of data in the field 
devices and include only the log entries directly relevant to an automatic restoration event.

The Instant Replay Log dialog box displays white and blue entries. See Figure 98. 
The white data are state points and have four categories that drive the graphic display 
changes as the event is played back. The categories are:

• Switch State

• Loss of Voltage

• Overcurrent

• SAT Active (version 7.3 and earlier releases)

Entries in the Description field describe the reason for the event. “Manual,” 
“IntelliTeam SG,” “SAT,” or “protection” are reasons for a switch-state change.

The blue data are event points and provide relevant information from the historic 
event log that is collected around the state points.

Overview

Figure 98 . Instant Replay log dialog box .
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Open a circuit file to begin the data-collection process. Select File>Open and browse to 
the circuit to be displayed. See Figures 99 and 100.

NOTICE
The circuit used must correspond to the present state of the system . During the 
data-collection process, the target Netlist (the Netlist in the field devices) is going 
to be checked against the Netlist associated with the open schematic . If the Netlists 
do not match, an error will be generated, and the collection process will terminate .

Collecting Data

Figure 99 . Open a circuit file .

Figure 100 . Open a Replay file .

S&C Instruction Sheet 1044-570  103

Instant Replay



Click the Communicate to Devices icon to open the communication manager dialog 
box. See Figures 101 and 102. The next step is to communicate with the devices. Because 
the device connection details are retained, it is advisable to set up all the devices and 
uncheck the Enable Device check box, described later, to exclude devices that are not 
part of the event.

Connection Setup

Figure 101 . The Communicate to Devices icon .

Figure 102 . Communication Manager dialog box .
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Connection Setup for 
Data Collection

STEP  1 .  Use the check boxes in the Manage Device List dialog box to select devices  
by feeder, or individually, for inclusion in the device list at the left of the 
Communication Manager dialog box. 

STEP  2 .  When a feeder has been selected, click on the check boxes next to the devices 
that need to have the Instant Replay logs collected for that feeder. See  
Figure 103 as an example.

Figure 103 . Device selection for Instant Replay collection .
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Figure 104 . Communication settings .

STEP  3 .  When all required devices have been entered in the connection list, set the 
Connection settings for each device. Typically, the connection type will be IP. 

Note: A Wi-Fi connection to an IntelliRupter fault interrupter requiring a 
LinkStart connection type is not a valid connection for log retrieval. A con-
nection to a network or headend communication device capable of reaching 
all of the devices in the device list is required.

If the headend communication device uses a serial connection, set the serial port 
and baud rate. The only other required settings are the username and password if the 
device needs them. IntelliTeam Designer stores the username with the rest of the Device 
settings, but the password must be entered each time the communication manager is 
closed and re-opened.

Because the communication manager remembers the settings for each device, it is 
desirable to keep devices in the list once they have been entered. A device that does not 
need to be part of data collection can be disabled by unchecking the Enable: check box 
in the Communication settings. See Figure 104.
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The Setting Common Communication Parameters fields are used for communication 
setup for the Netlist Push process. See Figure 98 on page 102.

Connection Type
Select the connection type that is used to connect to the entry point device. Options are: 
None, Serial, IP, LinkStart (WiFi), ICPSerial, ICPIP, and WAN.

NOTICE
The LinkStart connection type connects to only one device at a time . To propagate 
the FeederNet data, push a FeederNet to each device on the circuit one at a time . 
A LinkStart connection type should not be used for circuits with more than two 
devices .

DNP Address
The DNP Address field shows the DNP address of the entry point device. This value is 
programmed into the configuration based on the information configured in the Device 
Attributes tab. The Use Self option, when checked, uses the devices DNP self address 
instead of the programmed DNP address.

Serial Port
Select the serial port used to connect to a control when the connection type is specified 
for serial connections. Options are COM1 through COM250.

Retry Time (Seconds)
The Retry Time field shows the number of seconds each retry will be performed when 
a Netlist Push operation to an entry point device is not successful.

Retry Count
The Retry Count field shows the number of retries that will be performed when a Netlist 
Push operation to an entry point device is not successful.

Baud Rate
The Baud Rate field shows the baud rate that is used for serial connections. Options are: 
BR1200, BR2400, BR4800, BR9600, BR19200, BR38400, and BR57600.

Our RTU
The Our RTU field shows the RTU address of the device being used to connect to the 
entry point device. Use the default of 65431 unless otherwise instructed.

User Name
The User Name field shows the username used to connect to the entry point device.

Password
The Password field shows the password used to connect to the entry point device.

Setting Common 
Communication 
Parameters
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When all devices are chosen and configured, verify the connections before attempting 
to download data from the field devices. Click the Check button shown in Figure 100. 
The communication manager will connect to each device unless the Enable: check box 
has been unchecked. A progress dialog box will appear and remain open as long as the 
connection test is processing. If an error is encountered, the communication check will 
be terminated and an error message will be shown at the Operational Log tab shown 
in Figure 105.

Connection Check for 
Data Collection

Figure 105 . Communications Check and Operation Log .

Before retrieving the logs, follow these steps to set the Instant Replay retrieval options:

STEP  1 .  The Use PC Clock option can only be used with reasonably fast communication 
options such as SpeedNet™ Radios and only when round trip latency is three 
seconds or less for all devices. It is highly recommended Instant Replay be used 
only on systems where all devices have GPS. 

Misleading results are possible when the PC Clock option is used because 
of communication system variability. The PC Clock option is intended as a 
backup to be used if GPS should become unavailable before a critical event. 
Under this circumstance, the PC Clock option will provide better results than 
an uncorrected field-device clock. 

When not using the PC Clock option, the timestamp is entered in UTC 
time. When using the PC Clock option, the timestamp is entered in local time.

STEP  2 .  Set the Approx. Event Time setpoint as close to the event start as possible, 
while leaving a pre-event field to ensure nothing is missed.

STEP  3 .  Set the Approx. Duration setpoint as short as possible, but allow sufficient 
time to ensure there is a small post-event field.

STEP  4 .  Checking the Read Memory Log Only check box will pull additional data from 
the .EVT log and include it in the Instant Replay log when the replay is executed. 
The additional data includes EVT, DNP, and DAT logs from the .EVT file as well 
as the state and event points already included.

Note: Using the Read Memory Logs Only option may result in incomplete 
or inconsistent results because it reads additional data that may be lost 
over poor-performing communication networks. If this occurs, uncheck this 
option and retrieve the replay files again (without this additional data).

STEP  5 .  Checking the Recent Replays Only check box limits the number of event files 
checked and will speed up retrieval time. If the event occurred more than two 
hours before the retrieval attempt, this option should not be checked. See  
Figure 106 on page 109.

Retrieval Settings
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Figure 106 . The Instant Replay Retrieval dialog box .

After the replay file has been saved, it will be automatically imported into IntelliTeam 
Designer. To open a previously saved replay file, IntelliTeam Designer must be put in 
Instant Replay mode by clicking the Instant Replay Mode icon shown in Figure 108 
on page 110.

Opening Instant 
Replay File

STEP  6 .  When the connection has been verified, click the Collect button, shown in 
Figure 107, to start data collection. The progress will be shown at the 
Operational Log tab and will continue to display the progress of collecting 
the log files until either an error is encountered or the process has been 
completed.

STEP  7 .  When collection is complete, the Save Instant Replay dialog box will 
automatically open. Enter a name for the file, and select an appropriate location 
to save the file.

Figure 107 . The Collect instant replay log button .

Instant Replay relies on device timestamp precision. If the device clocks are not closely syn-
chronized, Instant Replay presentations will not be accurate. While IntelliTeam Designer 
provides for manual synchronization of events coming from devices with clocks that are not  
synchronized, correction ability is limited.

Resynchronization is fairly easy if device clocks are out of synchronization by several 
minutes or less. If timestamps are unsynchronized by more than a few minutes, additional 
care must be taken to make sure the events being viewed from each device are associ-
ated with the same circuit disturbance and that all events associated with that circuit 
disturbance have been collected. If poor clock synchronization prevents correct Instant 
Replay generation, S&C suggests using Instant Replay via the compact flash method, as 
long as the clocks in the participating devices have run linearly (have not jumped around) 
since the occurrence of the circuit disturbance under investigation.

Timestamps
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The Instant Replay file can opened two ways. Select File>Open Replay Log, as shown 
in Figure 109, and browse to the desired replay file. The Open button above the Instant 
Replay Log dialog box shown in Figure 110 can also be clicked to browse the Replay file.

Figure 109 . Opening a Replay file .

Figure 110 . Instant Replay option buttons .

Playback Controls

Figure 111 . Instant Replay playback buttons listed from left to right .

• Play

• Pause

• Stop

• Move First (go to the beginning) 

• Move Previous (back one log entry)

• Move Next (forward one log entry)

• Move Last (go to the end)

Figure 108 . Instant Replay Mode icon .
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When an event file is open, playback can be accomplished in a number of ways. The event 
can be played by clicking on the Play icon. See Figure 111 on page 110.

Step through an event by clicking the Move Previous and Move Next icons or by 
double clicking on a log entry in the Instant Replay Events dialog box, shown in Figure 110.

Checking the State Points Only check box, shown in Figure 111, filters out the events 
points, thereby reducing the display activity and the number of points seen in the Instant 
Replay Log dialog box.

The Playback screen, shown in Figure 112, contains the playback Comment box. 
Each time a new log entry is reached, the text field in the Comment box is updated with 
the Description field of the entry in the Instant Replay log. Arrows extending from the 
Comment box extend to each device affected by the log entry.

The black fields for the device indications and the black line segments indicate what 
has been affected by the voltage loss shown in the Comment box.

Checking the Hide Comment check box, shown in Figure 104, removes the Comment 
box and arrows from the display during playback.

Event Playback

Figure 112 . Playback screen with Comment box .
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If the exact time an event occurs is unknown, it may be necessary to use the  
maximum event time to capture a shorter event in the event log file. To break a log into 
shorter segments, click the Subsequences button shown in Figure 112 on page 111. The  
Select Subsequence dialog, shown in Figure 113, will open.

Enter a sequence association time in the text box to set the maximum size of the  
subsequence. The larger the number, the fewer the number of sequences into 
which the file is divided. After the association time has been entered, click on the 
Update Sequence button and the available sequences will display by starting 
time in the selection field. To play a subsequence, select it and click on the  
Use Selected button. To remove sequencing and revert back to the original log file, click 
on the Remove Sequencing button.

Subsequence

Figure 113 . The Select Subsequence dialog box .
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The event file can be exported into an HTML file format by clicking on the HTML button 
shown in Figure 112 on page 111. A sample of the output file is shown in Figure 114.

HTML Output

Figure 114 . Sample HTML output .

For more information about the Event Codes and Data columns in the HTML output, 
refer to:

• S&C Instruction Sheet 766-561, “IntelliRupter® PulseCloser® Fault Interrupter: 
IntelliRupter Data Log Messages”

• S&C Instruction Sheet 1043-551, “IntelliNode™ Interface Module: Troubleshooting”

• S&C Instruction Sheet 1045-550, “6800 Series Automatic Switch Controls:  
Troubleshooting”

S&C Instruction Sheet 1044-570  113

Instant Replay



Follow these steps to use a Compact Flash file:

STEP  1 .  Download the .EVT files that match the field event time frame from every 
participating device by using the IntelliLink Compact Flash access  
functionality.

STEP  2 .  Determine which devices participated in the field event for which the Instant 
Replay is being created. See Figure 115.

Using Compact Flash 
Files

STEP  3 .  Make sure there is a separate directory for each participating device that 
contains all available .EVT files for that device. Do not put .EVT files from 
different devices in the same directory, and do not put .EVT files from the same 
device into different directories.

STEP  4 .  In IntelliTeam Designer, switch to the Instant Replay mode and open the 
circuit loaded into the participating devices at the time the field event under 
investigation occurred.

STEP  5 .  Click the Communicate to Devices button in the upper toolbar. The 
IntelliTeam SG Communication Manager dialog box will open. Click on the  
Log Files tab. See Figure 116 on page 115.

Figure 115 . The Compact Flash Access screen .

Instant Replay log files can also be accessed via device Compact Flash files. To accom-
plish this, IntelliLink software can be used to gain access to and download the necessary 
Compact Flash files from the devices themselves. When done, the IntelliTeam Designer 
program can be used to extract the necessary data to display the Instant Replay event 
data in the Instant Replay viewer. 

Overview
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Figure 116 . The Communication Manager—Log Files screen .

STEP  6 .  Use the check boxes on the left side where all of the devices are shown and 
select all the devices that participated in the event. Add a single device or add 
all devices belonging to a specified FeederNet. See Figure 117.

Figure 117 . The Log File Device Selection dialog box .
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STEP  8 .  Use the Clock Offset configuration when the device clock is out of synchroniza-
tion by a known amount of time greater than several minutes. See Figure 119.

Figure 119 . The Clock Offset entry .

STEP  7 .  Double-click on the directory icon for each device and then search that 
directory for the necessary .EVT files. See Figure 118. Repeat this process until 
all .EVT files have been selected for all devices that were part of the event.

Figure 118 . The directory search for  .EVT files dialog box .
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STEP  9 .  Specify the Timestamp Time Zone, Approx. Event Time, and Duration for the 
event under investigation. The timestamp should be set a few minutes before 
the actual time the event began and the duration set a number of minutes longer 
than the event.

When the clocks in the participating devices are not perfectly synchronized,  
provide more leeway when entering event time and duration. The amount of 
leeway depends on how unsynchronized the device clocks are.

The Do Not Filter Events (Get All) check box uses every historic event in the 
specified timeframe for the Instant Replay. By default, only a few core events 
are incorporated, and we recommend the default. See Figure 120.

Figure 120 . The Communication Manager—Instant Replay Generation Setup dialog box .

STEP  10 .  Click on the Collect from Log button. A prompt to name and save the replay 
file will open. See Figure 121.

Figure 121 . The Collect from Log button .

Figure 122 . Success dialog box .

STEP  11 .  If no errors are encountered, the Success dialog box opens. See Figure 122. 
Click on the OK button, and close the Communication Manager screen.

S&C Instruction Sheet 1044-570  117

Instant Replay from Compact Flash Files



Figure 123 . Drawing Space populated with the Instant Replay data .

STEP  12 .  If some event data, such as switch operations, appear to be missing, open the 
Communication Manager screen and adjust the Approx. Event Time  
configuration. Make sure all participating devices have a proper directory with 
all relevant .EVT files configured.

STEP  13 .  If using controls with GPS, the control device time will be synchronized. If the 
clocks are not synchronized, manually adjust the timestamps:

(a) Enter Reorder Events mode by clicking on the Clock button on the Instant 
Replay bar below the circuit one-line diagram. The Reorder Selected 
button will open next to the Clock button. See Figure 124 on page 119.

IntelliTeam Designer is now populated with the Instant Replay generated from the 
data provided. See Figure 123.

Clock button
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Figure 124 . Timestamps selected for manual time adjustment .

(b) In the Instant Replay Log below the circuit diagram, select events from 
different devices known to have occurred at the same time. S&C recom-
mends checking the State Points Only check box above the Instant Replay 
Log. Hold the <CTRL> key to make multiple selections.

For example, if the event was an overcurrent, then all overcurrent events 
upstream of the faulted field are likely to have occurred at the same time. For 
a loss of substation source, all voltage losses on the affected FeederNet are 
likely to have occurred at the same time. If a switch opened, the open opera-
tion and voltage losses on downstream switches are likely to have occurred 
at the same time.

Note: If a device has multiple events happening at the same time, when the 
time is adjusted for one of the events, all events with that same timestamp 
from the same device will also be adjusted.
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Figure 125 . Synchronize Events From Different Devices dialog box .

(d) To synchronize all the other device clocks with one specific device, click to 
select the device to synchronize. See Figure 126 on page 121.

It isn’t necessary to adjust the timestamps for multiple events. Choose 
just one event and modify its timestamps, thus causing the timestamps of 
all events coming from the selected devices to be shifted so they are 
synchronized.

(e) Enter the timestamp manually. That will adjust the timestamps so all 
events coming from the selected devices will occur at the same time.

(f) Click on the Apply Changes button. This dialog box will close, and the 
event list below the circuit diagram will display events in the order modified, 
based on the input with this dialog. A pop-up message will be shown 
indicating the events have been re-ordered. See Figure 126 on page 121.

(c) When all events have been selected, click on the Reorder Selected button. 
The following dialog box will open. See Figure 125.
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(g) Usually one event is not shared by all controls, so repeat Step 12, starting on 
page 118, and alter timestamps for different groups of controls to get a 
correctly ordered Replay sequence.

(h) When the event order appears to be correct, click on the Clock button next 
to the Reorder Selected button. The Reorder Selected button will 
disappear, and the normal Instant Replay bar buttons will return.

(i) Click the Save As button to save the time-adjusted Instant Replay file for 
future reference.

Figure 126 . Synchronize Events From Different Devices dialog box .
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The Log Viewer allows easily reading and monitoring logs generated by IntelliTeam 
Designer. To open the Log Viewer, go to the Tools menu and click on the Log Viewer 
entry. Log Viewer data can also be exported to an Excel file; the default delimiter is “|” 
(the pipe symbol). See Figure 127.

Four log types can be loaded into the Log Viewer:

• Database Logs—Loads logs from S&C Electric databases (Make a valid  
database connection to read these logs.)

• Event Logs—Loads logs generated by Dialog boxes Event Viewer and filters based 
on key words

• Application Event Logs

• Security Event Logs

• File Logs—Loads any other log file (The default delimiter is the pipe symbol, but 
other delimiters can be used.)

Log Viewer Overview

Figure 127 . Log Viewer screen .
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Figure 128 . Log Viewer File menu .

Databases are created and stored in the DEM computer, and databases for larger 
IntelliTeam SG systems will be stored in an Oracle database. IntelliTeam Designer can 
be used to view a database file. Select the Data menu and click on the “Add Database 
Connection” entry. See Figure 129.

Log on to the server and the available databases will be displayed. Click to select the 
database name to open, and click on the Connect button. See Figure 130 on page 124.

Database Connection

To add a log file, click the File>Open and Add Log File... menu entry or to remove a 
log file, click on the menu entry: File>Remove Selected Log File.

The SCLogViewerSettings file has all the added and removed log files and database 
logs. Save the SCLogViewerSettings file in a different location that can be loaded  
separately. The default settings file is saved in Windows 10 as: c:\Users\<username>\ 
AppData\Local|S&CElectric\LogViewer\SCLogViewerSettings.xml. See Figure 128.

Log Viewer File Menu

Figure 129 . Log Viewer Data menu .
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Figure 130 . Add Database Connection dialog box .

After loading a log file, tail it by clicking on the Tailing File button. See Figure 131.  
Tailing a file adds real-time log lines to the file. The status bar shows whether tailing is 
occurring. Click on the Tailing File button again to stop the Tail process.

Tailing a Log

Figure 131 . Tailing File status bar .
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Filters

Figure 132 . Selecting log filter type .

When a log file has been loaded into IntelliTeam Designer, the events can be filtered to group 
data. Select the parameter to be filtered and filter range. Then, click on the Filter button:         . 
See Figure 132. 

Follow these steps to use filtering:

STEP  1 .  Select a filter type from the drop down list. Line Number, Date and Time, ID, 
Level, Category, and Description can be filtered.

STEP  2 .  Select a filter operator from the drop-down list.

• Line Number and ID use the Between filter operator that produces a 
range from  the starting to the end value. A starting or end value must 
be entered. If only the starting value is entered, the range starts at that 
value and continues to the end of the list. If only an end value is entered, 
the range starts at the beginning and ends at that value. The other filter 
types use the Equal or Contains filter.

• The Equal filter operator produces a data range that exactly matches 
the contents of the filter request and is case sensitive.

• The Contains filter operator produces a data range that includes the 
text of the filter request.

Logging Files For Log Viewer to open a log file, it must be saved in the .evt format. See S&C Instruction 
Sheet 1032-570, “Compact Flash Access: Operation,” for details on how to save a log file 
in the .evt format.
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Figure 133 . Normal Log File contents; the last line number is at the end of the list .

Figure 134 . Data filtered to start at Line Number 5 .

Figure 133 shows the normal contents of the log file.

STEP  3 .  The line number  can be filtered to start at #5. See Figure 134.
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Figure 136 . Data filtered to display from line number 3 to line number 5 .

Figure 135 . Data filtered to end at Line Number 5 .

STEP  4 .  The line number can be filtered to end at #5. See Figure 135.

STEP  5 .  The line number can be filtered to start a #3 and end at #5. See Figure 136.
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After a log file has been loaded into IntelliTeam Designer and the data filtered (if 
required), the data can be exported by clicking the Export button.

Figure 137 . Data filtered to display category entries equal to “Error .”

Figure 138 . The Enable IntelliTeam FMS Export button location .

Figure 139 . Exported text with the “|” (pipe symbol) default delimiter .

The export data is produced with a  |  (pipe) delimiter and can be imported into Excel 
using the  “|”  delimiter. See Figure 139.

STEP  6 .  The category can be filtered by the Equals filter operator. See Figure 137.

STEP  7 .  Click on the Filter button: . See Figure 132 on page 125. 

Enable expor t using the Enable Intel l iTeam FMS Export  button. See  
Figure 138.

Exporting Data
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The IntelliTeam FMS Feeder Management System must have a complete list of  
the system field devices and their communication parameters to retrieve data.  
IntelliTeam Designer contains this information and can export device parameters to  
the IntelliTeam FMS application. IntelliTeam Designer can also verify the IntelliTeam 
FMS device list.

To export IntelliTeam Designer data, open the Options menu and select the Enable  
FMS Export option. See Figure 140. 

Follow these steps to export IntelliTeam Designer data to the IntelliTeam FMS application:

STEP  1 .  Open the IntelliTeam Designer circuit from which data need to be exported.

STEP  2 .  Open the communication manager.

STEP  3 .  If IntelliTeam FMS communication with some of the field devices does not use 
the IP addresses configured in the Device Attributes tab of the circuit, then 
override the communication settings as necessary in the Device  
Configuration/Status tab.

STEP  4 .  Click on the FMS Export button on the Communication Manager toolbar.  
See Figure 141 on page 130.

STEP  5 .  The Check Netlist dialog box opens. See Figure 142 on page 130. This gives the 
option to verify the circuit data in the field devices matches the presently loaded 
circuit.

Exporting Data

Figure 140 . The Enable IntelliTeam FMS Export selection .
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Figure 141 . The Communication Manager toolbar, showing the FMS Export button .

STEP  6 .  Click on the No button to skip this check. Performing the check is recommended. 
Click on the Yes button in the Check Netlist dialog box. See Figure 142. If the 
Netlist check is not successful, it is recommended not to proceed and confirm 
the correct IntelliTeam Designer circuit was opened.

STEP  7 .  The FMS Export Dialog screen will open. See Figure 143.

Figure 142 . Check Netlist dialog box .

Figure 143 . The FMS Export Dialog screen .
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FMS 
Connection 
Standard

Specify the Host portion of the FMS url. Do not specify the 
protocol (i.e. “http” or “https”) or the port number (i.e. “:80”).

FMS 
Connection 
Custom

In some rare cases, the IntelliTeam FMS application cannot 
be located using the standard method noted above.

If that is the case, specify the Protocol, Port, and any 
additional path explicitly. Generally, the complete text in 
this field should match text typed in the browser to access 
the IntelliTeam FMS main Web page.

Disable 
Certificate 
Checking

The Disable Certificate Checking option allows a user to 
disable certificate checking with IntelliTeam Designer when 
HTTPS is used as the protocol. This will allow IntelliTeam 
Designer to use HTTPS with the IntelliTeam FMS system 
without the use of certificates to authenticate the two appli-
cations. This option is enabled by default. Disabling this 
option when using HTTPS will result in an error between 
IntelliTeam Designer and IntelliTeam FMS.

HTTP   Timeout The HTTP Timeout feature controls how long it takes for 
IntelliTeam Designer to time out during Export Data and 
Get List operations. Increase this if the system is slow, or 
the amount of data is very large.

Data Transfer/ 
Export Data to 
FMS

The Data Transfer/Export Data to FMS feature trans-
mits the list of devices contained in the presently loaded 
IntelliTeam Designer circuit and their communication 
parameters from IntelliTeam Designer to the IntelliTeam 
FMS application. If the operation is successful, the 
IntelliTeam FMS application will be able to talk to the 
devices immediately upon completion. This operation also 
includes configuration of the device access server (DAS).

Note: A device can never be deleted from the IntelliTeam 
FMS software after its data have been imported.

Note: Do not export circuits with duplicate device or  
substation names. This is not presently supported.

FMS Export Features
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Data Transfer/ 
Get List of 
FMS Devices

The Data Transfer/Get List of FMS Devices function 
retrieves the list of all devices the IntelliTeam FMS applica-
tion is presently configured to use. The retrieved data also 
includes some key parameters: Connectivity Set (Designer 
Circuit Name), Device Type, DNP Address, and IP Address.

This feature may be used to verify device data before or 
after the export operation.

Status The Status function is the present state of the IntelliTeam 
FMS data transfer process. The possible states are:

Idle—Appears only when the dialog is first brought up

In Progress—A data transfer operation is in progress 
(All other IntelliTeam Designer functionality is blocked in 
this state until it succeeds, an error is encountered, or the 
operation times out.)

Success—Appears when one of the two supported data 
transfer operations succeeds

Error—Appears when the requested operation did not 
succeed (There are numerous possible error states.)

Detailed 
Operation Data/
Clear Log

The Detailed Operation Data/Clear Log feature clears 
the log of the detailed operation data.
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In some cases, the Export operation may not complete successfully. The Status  
indication will contain the exact error code and the Detailed Operation Data Log will con-
tain any additional descriptions. Possible error conditions are shown in Table 2.

Table 2 . Export Error Codes

Error Code Description Corrective Action

CONNECTION_ERROR IntelliTeam Designer could 
not connect to IntelliTeam 
FMS application

Make sure the IntelliTeam FMS 
connection is set up correctly

DATA_ERROR IntelliTeam FMS application 
did not accept the data . The 
log will contain additional 
information

If the error description is stated 
in the log, close the FMS Export 
Dialog box, correct the error, and 
try again . 
Otherwise, contact S&C and 
provide the entire contents of the 
log

DAS_ERROR_ 
CONNECT

IntelliTeam FMS application 
could not connect to DAS

Make sure the DAS Server IP 
address and port parameters are 
set correctly on the Settings page 
of the IntelliTeam FMS application

DAS_ERROR DAS did not accept the 
configuration . The log 
will contain additional 
information .
When this error is 
encountered during the 
Export operation, DAS 
configuration is disabled, 
and the IntelliTeam FMS 
application will not be able to 
talk to any devices

If the error description is stated 
in the log, close the FMS Export 
Dialog box, correct the error, and 
try again .
Otherwise, contact S&C and 
provide the entire contents of the 
log

DAS_ERROR_
ROLLEDBACK

DAS did not accept the 
configuration . The log 
will contain additional 
information .
When this error is 
encountered during the 
Export operation, the current 
DAS configuration (before the 
last export attempt) remains 
active and the IntelliTeam 
FMS application will continue 
to collect data based on that 
configuration

If the error description is stated 
in the log, close the FMS Export 
Dialog, correct the error and try 
again .
Otherwise, contact S&C and 
provide the entire contents of the 
log

BAD_FMS_ 
FEEDBACK

IntelliTeam Designer received 
an unexpected reply from the 
IntelliTeam FMS application

Contact S&C and provide the 
entire contents of the log

ERROR An unknown error occurred Make sure the IntelliTeam FMS 
connection parameters are 
correct . If so, contact S&C and 
provide the entire contents of the 
log
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